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© Cypress Semiconductor Corporation, 2013-2018. This document is the property of Cypress Semiconductor Corporation
and its subsidiaries, including Spansion LLC ("Cypress"). This document, including any software or firmware included or refer-
enced in this document ("Software"), is owned by Cypress under the intellectual property laws and treaties of the United
States and other countries worldwide. Cypress reserves all rights under such laws and treaties and does not, except as spe-
cifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property
rights. If the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with
Cypress governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable
license (without the right to sublicense) (1) under its copyright rights in the Software (a) for Software provided in source code
form, to modify and reproduce the Software solely for use with Cypress hardware products, only internally within your organi-
zation, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through resell-
ers and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress's patents that
are infringed by the Software (as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely
for use with Cypress hardware products. Any other use, reproduction, modification, translation, or compilation of the Software
is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE. No computing device can be absolutely secure. Therefore, despite security measures implemented in Cypress hard-
ware or software products, Cypress does not assume any liability arising out of any security breach, such as unauthorized
access to or use of a Cypress product. In addition, the products described in these materials may contain design defects or
errors known as errata which may cause the product to deviate from published specifications. To the extent permitted by
applicable law, Cypress reserves the right to make changes to this document without further notice.

Cypress does not assume any liability arising out of the application or use of any product or circuit described in this document.
Any information provided in this document, including any sample design information or programming code, is provided only
for reference purposes. It is the responsibility of the user of this document to properly design, program, and test the function-
ality and safety of any application made of this information and any resulting product. Cypress products are not designed,
intended, or authorized for use as critical components in systems designed or intended for the operation of weapons, weap-
ons systems, nuclear installations, life-support devices or systems, other medical devices or systems (including resuscitation
equipment and surgical implants), pollution control or hazardous substances management, or other uses where the failure of
the device or system could cause personal injury, death, or property damage ("Unintended Uses"). A critical component is
any component of a device or system whose failure to perform can be reasonably expected to cause the failure of the device
or system, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and hereby do release
Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses of Cypress products. You
shall indemnify and hold Cypress harmless from and against all claims, costs, damages, and other liabilities, including claims
for personal injury or death, arising from or related to any Unintended Uses of Cypress products.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-
RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a more
complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their respec-
tive owners.

PSoC Designer, PSoC Creator, SmartSense, and CapSense Express are trademarks of Cypress Semiconductor Corpora-
tion.
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Regulatory Compliance

The CY8CKIT-042 PSoC® 4 Pioneer Kit is intended for use as a development platform for hardware
or software in a laboratory environment. The board is an open system design, which does not
include a shielded enclosure. Due to this reason, the board may cause interference to other
electrical or electronic devices in close proximity. In a domestic environment, this product may cause
radio interference. In such cases, the user may be required to take adequate preventive measures.
Also, this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-042 as shipped from the factory has been verified to meet with requirements of CE as
a Class A product.

The CY8CKIT-042 contains electrostatic discharge (ESD) sensitive

| devices. Electrostatic charges readily accumulate on the human body

and any equipment, and can discharge without detection. Permanent
damage may occur on devices subjected to high-energy discharges.

\ Proper ESD precautions are recommended to avoid performance
degradation or loss of functionality. Store unused CY8CKIT-042

boards in the protective shipping package.

End-of-Life/Product Recycling

This kit has an end-of-life cycle five years from the date of
manufacturing mentioned on the back of the box. Contact your nearest
recycler for discarding the Kkit.
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General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform
procedures only at an ESD workstation. If an ESD workstation is not available, use appropriate ESD
protection by wearing an antistatic wrist strap attached to the chassis ground (any unpainted metal
surface) on the board when handling parts.

Handling Boards

CY8CKIT-042 boards are sensitive to ESD. Hold the board only by its edges. After removing the
board from its box, place it on a grounded, static free surface. Use a conductive foam pad if
available. Do not slide board over any surface.
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Thank you for your interest in the PSoC® 4 Pioneer Kit. The kit is designed as an easy-to-use and
inexpensive development kit, showcasing the unique flexibility of the PSoC 4 architecture. Designed
for flexibility, this kit offers footprint-compatibility with several third-party Arduino™ shields. This kit
has a provision to populate an extra header to support Digilent® Pmod™ peripheral modules. In
addition, the board features a CapSense® slider, an RGB LED, a push button switch, an integrated
USB programmer, a program and debug header, and USB-UART/I2C bridges. This kit supports
either 5 V or 3.3 V as power supply voltages.

The PSoC 4 Pioneer Kit is based on the PSoC 4200 device family, delivering a programmable
platform for a wide range of embedded applications. The PSoC 4 is a scalable and reconfigurable
platform architecture for a family of mixed-signal programmable embedded system controllers with
an Arm® Cortex™-MO0 CPU. It combines programmable and reconfigurable analog and digital blocks
with flexible automatic routing.

1.1 Kit Contents

The PSoC 4 Pioneer kit contains:

m PSoC 4 Pioneer board

m Quick Start Guide

m USB Standard-A to Mini-B cable
m  Six jumper wires

CY8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J 7



&= CYPRESS

~amp EMBEDDED IN TOMORROW Introduction

Figure 1-1. Kit Contents
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Inspect the contents of the kit; if you find any part missing, contact your nearest Cypress sales office
for help: www.cypress.com/support.
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1.2 PSoC Creator™

PSoC Creator is a state-of-the-art, easy-to-use integrated design environment (IDE). It introduces
revolutionary hardware and software co-design, powered by a library of pre-verified and pre-
characterized PSoC Components™.

With PSoC Creator, you can:

m Drag and drop PSoC components to build a schematic of your custom design

m Automatically place and route components and configure GPIOs

m Develop and debug firmware using the included component APls

PSoC Creator also enables you to tap into an entire tools ecosystem with integrated compiler chains
and production programmers for PSoC devices.

For more information, visit www.cypress.com/creator.

1.3 Getting Started

This guide helps you to get acquainted with the PSoC 4 Pioneer Kit.
m The Software Installation chapter on page 14 describes the installation of the kit software.

m The Kit Operation chapter on page 17 explains how to program the PSoC 4 with a programmer
and debugger — either the onboard PSoC 5LP or the external MiniProg3 (CY8CKIT-002).

The Hardware chapter on page 27 details the hardware operation.
The Code Examples chapter on page 43 describes the code examples.

The Advanced Topics chapter on page 65 deals with topics such as building projects for
PSoC 5LP, USB-UART functionality, and USB-12C functionality of PSoC 5LP.

m The Appendix on page 116 provides the schematics, pin assignment, use of zero-ohm resistors,
troubleshooting, and the bill of materials (BOM).

CY8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J 9
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1.4 Additional Learning Resources

Cypress provides a wealth of data at www.cypress.com to help you to select the right PSoC device
for your design, and to help you to quickly and effectively integrate the device into your design. For a
comprehensive list of resources, see KBA86521, How to Design with PSoC 3, PSoC 4, and
PSoC 5LP. The following is an abbreviated list for PSoC 4:

Overview: PSoC Portfolio, PSoC Roadmap

Product Selectors: PSoC 1, PSoC 3, PSoC 4, or PSoC 5LP. In addition, PSoC Creator includes
a device selection tool.

Datasheets: Describe and provide electrical specifications for the PSoC 4000, PSoC 4100, and
PSoC 4200 device families.

CapSense Design Guide: Learn how to design capacitive touch-sensing applications with the
PSoC 4 family of devices.

Application Notes and Code Examples: Cover a broad range of topics, from basic to advanced
level. Many of the application notes include code examples. Visit the PSoC 3/4/5 Code Examples
webpage for a list of all available PSoC Creator code examples. For accessing code examples
from within PSoC Creator — see PSoC Creator Code Examples on page 12.

Technical Reference Manuals (TRM): Provide detailed descriptions of the architecture and
registers in each PSoC 4 device family.

Development Kits:

o CY8CKIT-042 and CY8CKIT-040, PSoC 4 Pioneer Kits, are easy-to-use and inexpensive
development platforms. These kits include connectors for Arduino compatible shields and
Digilent Pmod daughter cards.

o CY8CKIT-049 is a very low-cost prototyping platform for sampling PSoC 4 devices.
a CY8CKIT-001 is a common development platform for all PSoC family devices.
The MiniProg3 device provides an interface for flash programming and debug.

Knowledge Base Articles (KBA): Provide design and application tips from experts on the
devices/kits. For instance, KBA93541, explains how to use CY8CKIT-049 to program another
PSoC 4.

For a list of trainings on PSoC Creator, visit www.cypress.com/training.

CYB8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J 10
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PSoC Creator

Introduction

PSoC Creator is a free Windows-based integrated design environment (IDE). It enables concurrent
hardware and firmware design of systems based on PSoC 3, PSoC 4, and PSoC 5LP. See

Figure 1-2 — with PSoC Creator, you can:

1. Drag and drop Components to build your hardware system design in the main design workspace

oD

Explore the library of 100+ Components
5. Access Component datasheets

Figure 1-2. PSoC Creator Features
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Visit PSoC Creator training page for video tutorials on learning and using PSoC Creator.
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14.2 PSoC Creator Code Examples

PSoC Creator includes a large number of code examples. These examples are accessible from the
PSoC Creator Start Page, as Figure 1-3 shows.

Code examples can speed up your design process by starting you off with a complete design,
instead of a blank page. They also show how PSoC Creator Components can be used for various
applications.

In the Find Code Example dialog, you have several options:

Filter for examples based on device family or keyword.

Select from the list of examples offered based on the Filter Options.

View the project documentation for the selection (on the Documentation tab).

View the code for the selection on the Sample Code tab. You can copy the code from this win-
dow and paste to your project, which can help speed up code development.

m Create a new workspace for the code example or add to your existing workspace. This can
speed up your design process by starting you off with a complete, basic design. You can then
adapt that design to your application.

Figure 1-3. Code Examples in PSoC Creator

Start Page |

Learn
Getting Acguainted
New in 4.2
News and Information

Start
Create New Project...
Open Existing Project...
Find Code Example ...
= Kits ©

1.4.3 PSoC Creator Help

Visit the PSoC Creator home page to download the latest version of PSoC Creator. Then, launch

PSoC Creator and navigate to the following items:

m Quick Start Guide: Choose Help > Documentation > Quick Start Guide. This guide gives you
the basics for developing PSoC Creator projects.

m Simple Component Code Examples: Choose File > Code Example. These code examples
demonstrate how to configure and use PSoC Creator Components. To access code examples
related to a specific Component, place the Component on the TopDesign schematic and right-
click on the Component. Select the Find Code Example option in the context menu that
appears.

m System Reference Guide: Choose Help > System Reference Guide. This guide lists and
describes the system functions provided by PSoC Creator.

m Component Datasheets: Right-click a Component and select Open Datasheet. Visit the
PSoC 4 Component Datasheets page for a list of all PSoC 4 Component datasheets.
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144 Technical Support

Introduction

If you have any questions, our technical support team is happy to assist you. You can create a sup-
port request on the Cypress Technical Support page.

If you are in the United States, you can talk to our technical support team by calling our toll-free num-
ber: +1-800-541-4736. Select option 3 at the prompt.

You can also use the following support resources if you need quick assistance.

m Self-help

m Local Sales Office Locations

1.5 Documentation Conventions

Table 1-1. Document Conventions for Guides

Convention

Usage

Courier New

Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Italics

Displays file names and reference documentation:

Read about the sourcefile.hex file in the PSoC Creator User Guide.

[Bracketed, Bold]

Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open

Represents menu paths:
File > Open > New Project

Bold

Displays commands, menu paths, and icon hames in procedures:
Click the File icon and then click Open.

Times New Roman

Displays an equation:
2+2=4

Text in gray boxes

Describes cautions or unique functionality of the product.

CY8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J
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2.1 Install Kit Software

Follow these steps to install the CY8CKIT-042 PSoC 4 Pioneer Kit software:

1. Download the kit software from www.cypress.com/CY8CKIT-042. The kit software is available for
download in three formats.

a.

CY8CKIT-042 Kit Complete Setup: This installation package contains the files related to the
kit including PSoC Creator and PSoC Programmer. However, it does not include the Windows
Installer or Microsoft .NET framework packages. If these packages are not on your computer,
the installer directs you to download and install them from the Internet.

CY8CKIT-042 Kit Only: This executable file installs only the kit contents, which include kit
code examples, hardware files, and user documents. This package can be used if all the
software prerequisites (listed in step 5) are installed on your computer.

CY8CKIT-042 DVD ISO: This file is a complete package, stored in a DVD-ROM image format,
which you can use to create a DVD or extract using an ISO extraction program such as
WinZip® or WinRAR. The file can also be mounted similar to a virtual CD/DVD using virtual
drive programs such as Virtual CloneDrive and MagiclSO. This file includes all the required
software, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it in a virtual drive. Extract the ISO contents if you do
not have a virtual drive to mount. Double-click cyautorun.exe in the root directory of the extracted
content or mounted ISO if "Autorun from CD/DVD" is not enabled on the computer. The
installation window will appear automatically.

Note: If you are using the "Kit Complete Setup" or "Kit Only" file, then go to step 4 for
installation.
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3. Click Install CY8CKIT-042 PSoC 4 Pioneer Kit to start the kit installation, as shown in
Figure 2-1.

Figure 2-1. Kit Installer Screen

r ~
€= CYBCKIT-042 PSaC 4 Pioneer Kit =

&= CYPRESS

g~ EMBEDDED IN TOMORROW™

CY8CKIT-042 PSoC 4 Pioneer Kit

Open the Kit User's Guide...
Install CYSCKIT-042 PSoC 4 Pioneer Kit...

Exit

@ 2018 Cypress Semiconductor Corporation. All rights reserved

4. Select the directory in which you want to install the files related to the CY8CKIT-042 PSoC 4
Pioneer Kit. Choose the directory and click Next.

5. The CY8CKIT-042 PSoC 4 Pioneer Kit installer automatically installs the required software, if itis
not present on your computer. Following are the required software:

a. PSoC Creator 4.2 or later: This software is also available at www.cypress.com/psoccreator.

b. PSoC Programmer 3.27.1 or later: This is installed as part of PSoC Creator installation
(www.cypress.com/programmer).

6. Choose the Typical, Custom, or Complete installation type (select Typical if you do not know
which one to select) in the Product Installation Overview window, as shown in Figure 2-2. Click
Next after you select the installation type.
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Figure 2-2. Product Installation Overview
ri‘;- Cylnstaller for CYBCKIT-042 PSaC 4 Pioneer Kit R
Product Installation Overview
Choose the install type that best suits your needs
Choose the type of installation
Product:
CYBCKIT-042 PSoC 4 Pioneer Kit
Installation Type:
Installs the most common features of
CYBCKIT-042 PSoC 4 Pioneer Kit.
[t ) [ oo ]
7. Read the License agreement and select | accept the terms in the license agreement to
continue with the installation. Click Next.
8. When the installation begins, a list of packages appears on the installation page. A green check
mark appears next to each package after successful installation.
9. Enter your contact information or select the Continue Without Contact Information check box.
Click Finish to complete the kit installation.
10.After the installation is complete, the kit contents are available at the following location:
<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit
Default location:
Windows OS (64-bit):
C:\Program Files (x86)\Cypress\CY8CKIT-042 PSoC 4 Pioneer Kit
Windows OS (32-bit):
C:\Program Files\Cypress\CY8CKIT-042 PSoC 4 Pioneer Kit
Note: For Windows 7/8/8.1/10 users, the installed files and the folder are read-only. To use the
installed code examples, follow the steps outlined in the Code Examples chapter on page 43. These
steps will create an editable copy of the example in a path that you choose, so the original installed
example is not modified.
Uninstall Software

The software can be uninstalled using one of the following methods:

1. Go to Start > All Programs > Cypress > Cypress Update Manager and select the Uninstall
button next to the product that needs to be uninstalled.

2. Go to Start > Control Panel > Programs and Features for Windows 7 or Add/Remove
Programs for Windows XP and select the Uninstall button.
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The PSoC 4 Pioneer Kit can be used to develop applications using the PSoC 4 family of devices and
the Arduino shields and Digilent Pmod daughter cards. Figure 3-1 is an image of the PSoC 4
Pioneer board with a markup of the onboard components.

Figure 3-1. PSoC 4 Pioneer Board

System Power

Arduino Arduino PSoC4
Programmer Supply Jumper  compatible Compatible Power Supply RGB
Status LED (9) 1/0 Header (J3) 1/0 Header (J4) Jumper (J13) gD

10-Pin SWD Ardfxino
Debug and Programming Compatible ICSP
Header (J7) for PSoC 5LP 1/0 Header (J12)
USB Connector
(J10)
Power LED Cans
apSense
VIN (J11) S’:ider
PSoC 4 Additional

Program Header (J6)

PSoC5LP I/O
Header (J8)

PSoC4
Reset
Button

Digilent Pmod PSoC 5LP Arduino PSoC 4 Arduino

User
Compatible Programmer Compatible g4 TqQFp Compatible Button
1/0 Header (J5) and 1/0 Header 1/0 Header
Debugger (J1) (J2)
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3.1 Pioneer Kit USB Connection
The PSoC 4 Pioneer Kit connects to the PC over a USB interface. The kit enumerates as a
composite device and three separate devices appear under the Device Manager window in the
Windows operating system.

Table 3-1. PSoC 4 Pioneer Kit in Device Manager After Enumeration

Port Description
USB Composite Device Composite device
USB Input Device USB-IC bridge, KitProg command interface
KitProg Programmer and debugger
KitProg USB-UART USB-UART bridge, which appears as the COM# port

Figure 3-2. KitProg Driver Installation

. Driver Software Installation Iéj
Your device is ready to use
USB Composite Device + Ready to use
USE Input Device + Ready to use
KitProg (1.2.3.3) af Ready to use
KitProg USB-UART (COM28) +f Ready to use

Close
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3.2 Programming and Debugging PSoC 4

The kit allows programming and debugging of the PSoC 4 device in two modes:
m Using the onboard PSoC 5LP programmer and debugger
m Using a CY8CKIT-002 MiniProg3 programmer and debugger

3.2.1 Using the Onboard PSoC 5LP Programmer and Debugger

The default programming interface for the kit is a USB-based, onboard programming interface.
Before trying to program the device, PSoC Creator and PSoC Programmer must be installed. See
Install Kit Software on page 14 for information on installing the kit software.

1. To program the device, plug the USB cable into the programming USB connector J10, as shown
in Figure 3-3. The kit will enumerate as a composite device. See Pioneer Kit USB Connection on
page 18 for details.

Figure 3-3. Connect USB Cable to J10

i P a,.{. "’l-i‘rt,
o7 0.3 5

CYBCKIT-042

=4

css1

2. The onboard PSoC 5LP uses serial wire debug (SWD) to program the PSoC 4 device. See
Figure 3-4 for this implementation.

Figure 3-4. SWD Programming PSoC 4 Using PSoC 5LP

VDD
T
P2[1] 2WOCLK 1 53
— D+
Mini P15[6] SWDIO
! P2[0 >
USB |-B R PSoC 5LP [0] P32 PSoC 4
pora) | —Reset I yRES

~
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3. The Pioneer Kit's onboard programmer will enumerate on the PC and in the software tools as
KitProg. Load a code example in PSoC Creator (such as the examples described in the Code
Examples chapter on page 43) and initiate the build by clicking Build > Build Project or

[Shift]+[F6].

Figure 3-5. Build Project in PSoC Creator
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4. After the project is built without errors and warnings, select Debug > Program or [Ctri]+[F5] to

program the device.

Figure 3-6. Program Device

from PSoC Creator
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L[] device.h .
EHD Source Files ASHE U L ’
o Le] maine >

EHj Generated_Source

Lt
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The onboard programmer supports only the RESET programming mode. When using the onboard
programmer, the board can either be powered by the USB (VBUS) or by an external source such as
an Arduino shield. If the board is already powered from another source, plugging in the USB

programmer does not damag

e the board.
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3.2.2 Using CY8CKIT-002 MiniProg3 Programmer and Debugger

The PSoC 4 on the Pioneer Kit can also be programmed using a MiniProg3 (CY8CKIT-002). To use
MiniProg3 for programming, use the J6 connector on the board, as shown in Figure 3-7.

The board can also be powered from the MiniProg3. To do this, select Tool > Options. In the
Options window, expand Program and Debug > Port Configuration; click MiniProg3 and select
the settings shown in Figure 3-8. Click Debug > Program to program and power the board.

Note: The CY8CKIT-002 MiniProg3 is not part of the PSoC 4 Pioneer Kit contents. It can be
purchased from the Cypress Online Store.

Figure 3-7. PSoC 4 Programming/Debugging Using MiniProg3
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Figure 3-8. MiniProg3 Configuration

Options [ 2 i&_J
-- Project Management Active Protocol:

[#- Design Entry

- Language Suppor Clock Speed: | 1.6 MHz -

- Text Editor Power Acquire Mode

i General @ 50V @ Reset
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- KitProg
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[#- Environment
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Restore All Defaults 0K l [ Apply I [ Cancel

Note: See the Programmer User Guide for more information on programming using a MiniProg3.

USB-UART Bridge

The onboard PSoC 5LP can also act as a USB-UART bridge to transfer and receive data from the
PSoC 4 device to the PC via the COM terminal software. When the USB mini-B cable is connected
to J10 of the PSoC 4 Pioneer Kit, a device named KitProg USB-UART is available under Ports
(COM & LPT) in the device manager. For more details about the USB-UART functionality, see Using
PSoC 5LP as a USB-UART Bridge on page 65.

To use the USB-UART functionality in the COM terminal software, select the corresponding COM
port as the communication port for transferring data to and from the COM terminal software.

The UART lines from PSoC 5LP are brought to the P12[6] (J8.9) and P12[7] (J8.10) pins of header
J8. This interface can be used to send or receive data from any PSoC 4 design that has a UART by
connecting the pins on header J8 to the RX and TX pins assigned in PSoC 4. The UART can be
used as an additional interface to debug designs. This bridge can also be used to interface with
other external UART-based devices. Figure 3-9 shows the connection between the RX and TX lines
of the PSoC 5LP and PSoC 4. In this example, the PSoC 4 UART has been routed to the J4 header;
the user must connect the wires between the PSoC 5LP RX and TX lines available on header J8.
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Figure 3-9. Example RX and TX Line Connection of PSoC 5LP and PSoC 4

Table 3-2 lists the specifications supported by the USB-UART bridge.

Table 3-2. Specifications Supported by USB-UART Bridge

Parameter Supported Values
Baud Rate 1200, 2400, 4800, 9600, 19200, 38400, 57600, and 115200
Data Bits 8
Parity None
Stop Bits 1
Flow Control None
File transfer protocols Xmodem, 1K Xmodem, Ymodem, Kermit, and Zmodem (only speeds greater
supported than 2400 baud).
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3.4 USB-I2C Bridge

The PSoC 5LP also functions as a USB-12C bridge. The PSoC 4 communicates with the PSoC 5LP
using an 12C interface and the PSoC 5LP transfers the data over the USB to the USB-I2C software
utility on the PC, called the Bridge Control Panel (BCP).

The BCP is available as part of the PSoC Programmer installation. This software can be used to
send and receive USB-12C data from the PSoC 5LP. When the USB mini-B cable is connected to
header J10 on the Pioneer Kit, the KitProg/<serial_number> is available under Connected 12C/
SPI/RX8 Ports in the BCP.

Figure 3-10. Bridge Control Panel
"% Bridge Control Panel e ) |

File Editor Chart Execute Tools Help
SRE TR EEER
Editor | Chant [ Table | File

Select Port in the PortlList, then try to connect =
Opening Port

Successfully Connected to KitProg/1222172E03242400

KitProg Version 2.00

Select Port in the Portlist, then try to connect Connect Button

Connected 12C/SPI/RXE Ports

® i m KitProg/1222172E03242400 2
& e :

7 __teom il -
@ e | B | @ 8 lcow
= ] e
[k |Symax:0l( | _ 7777777 7777777 Voltage: -

To use the USB_12C functionality, select the KitProg/<serial_number> in the BCP. On successful
connection, the Connected and Powered tabs turn green.
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Figure 3-11. KitProg USB-I2C Connected in Bridge Control Panel
ﬁ Bridge Control Panel = |E= &‘
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USB-I2C is implemented using the USB and 12C components of PSoC 5LP. The SCL (P12_0) and
SDA (P12_1) lines from the PSoC 5LP are connected to SCL (P3_0) and SDA (P3_1) lines of the
PSoC 4 12C. The USB-I2C bridge currently supports 12C speed of 50 kHz, 100 kHz, 400 kHz, and
1 MHz.

Refer to Using PSoC 5LP as USB-12C Bridge on page 79 for building a project, which uses USB-12C
Bridge functionality.

3.5 Updating the Onboard Programmer Firmware

The firmware of the onboard programmer and debugger, PSoC 5LP, can be updated from PSoC
Programmer. When a new firmware is available or when the KitProg firmware is corrupt (see Error in
Firmware/Status Indication in Status LED on page 124), PSoC Programmer displays a warning
indicating that new firmware is available.

Open PSoC Programmer from Start > All Programs > Cypress > PSoC Programmer<version>.
When PSoC Programmer opens, a WARNING! window pops up saying that the programmer is
currently out of date.

Figure 3-12. Firmware Update Warning
B WARNING! [

This programmer is currently out of date.

To update the firmware please navigate to the
Utilities Tab and press the Update Firmware
button

[ Do not show this message again
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Click OK to close the window. On closing the warning window, the Action and Results window
displays “Please navigate to the Utilities tab and click the Upgrade Firmware button”.

Figure 3-13. Upgrade Firmware Message in PSoC Programmer
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Opening Port at 3:48:09 PM
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Memory Types Load from HEX F...

Device set to CYBC6247BZI-D5... 1048576 FLASH bytes

For Help, press F1 | |- _ ‘

Click the Utilities tab and click the Upgrade Firmware button. On successful upgrade, the Action
and Results window displays the firmware update message with the KitProg version.

Figure 3-14. Firmware Updated in PSoC Programmer
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4.1 Board Details

The PSoC 4 Pioneer Kit consists of the following blocks:
PSoC 4

PSoC 5LP

Power supply system

Programming interfaces (J6, J7 - unpopulated, J10)
Arduino compatible headers (J1, J2, J3, J4, and J12 - unpopulated)
Digilent Pmod compatible header (J5 - unpopulated)
PSoC 5LP GPIO header (J8)

CapSense slider

Pioneer board LEDs

Push buttons (Reset and User buttons)

Figure 4-1. PSoC 4 Pioneer Kit Details
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Figure 4-2. PSoC 4 Pioneer Kit Pin Mapping
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This section provides the block-level description of the PSoC 4 Pioneer Kit.

Figure 4-3. Block Diagram
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The PSoC 4 is a new generation of programmable system-on-chip devices from Cypress for
embedded applications. It combines programmable analog, programmable digital logic,
programmable I/O, and a high-performance Arm Cortex-M0 subsystem. With the PSoC 4, you can
create the combination of peripherals required to meet the application specifications.

The PSoC 4 Pioneer Kit features an onboard PSoC 5LP, which communicates through the USB to
program and debug the PSoC 4 using serial wire debug (SWD). The PSoC 5LP also functions as a
USB-I12C bridge and USB-UART bridge.

The Pioneer Kit has an RGB LED, a status LED, and a power LED. The RGB LED is connected to
the PSoC 4 and the status LED is connected to the PSoC 5LP. For more information on the status
LED, see section A.5 Error in Firmware/Status Indication in Status LED on page 124. This kit also
includes a reset button that connects to the PSoC 4 XRES, a user button, and a five-segment
CapSense slider, which can be used to develop touch-based applications. The PSoC 4 pins are
brought out onto headers J1 to J4 on the kit to support Arduino shields. The PSoC 5LP pins are
brought out onto header J8 to enable using the onboard PSoC 5LP to develop custom applications.

The PSoC 4 Pioneer Kit can be powered from the USB Mini B, the Arduino compatible header, or an
external power supply. The input voltage is regulated by a low drop-out (LDO) regulator to 3.3 V. You
can select between VBUS (5 V) and 3.3 V by suitably plugging the jumper onto the voltage selection
header VDD.
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4.3 Functional Description

4.3.1 PSoC 4

This kit uses the PSoC 4200 family device. PSoC 4200 devices are a combination of a
microcontroller with programmable logic, high-performance analog-to-digital conversion, two
opamps with comparator mode, and commonly used fixed-function peripherals. For more
information, refer to the PSoC 4 webpage and the PSoC 4200 family datasheet.

Features

32-bit MCU subsystem

o 48 MHz Arm Cortex-M0O CPU with single cycle multiply
o Up to 32 KB of flash with read accelerator

o Up to 4 KB of SRAM

Programmable analog

o Two opamps with reconfigurable high-drive external and high-bandwidth internal drive, com-
parator modes, and ADC input buffering capability

o 12-bit 1-Msps SAR ADC with differential and single-ended modes; channel sequencer with
signal averaging

o Two current DACs (IDACs) for general-purpose or capacitive sensing applications on any pin
o Two low-power comparators that operate in deep sleep
Programmable digital

a Four programmable logic blocks called universal digital blocks (UDBs), each with eight Macro-
cells and data path

o Cypress-provided peripheral component library, user-defined state machines, and Verilog
input

Low power 1.71 to 5.5 V operation

o 20-nA Stop mode with GPIO pin wakeup

o Hibernate and Deep-Sleep modes allow wakeup-time versus power trade-offs

Capacitive sensing

o Cypress Capacitive Sigma-Delta (CSD) provides best-in-class SNR (greater than 5:1) and
water tolerance

o Cypress-supplied software component makes capacitive sensing design easy
o Automatic hardware tuning (SmartSense™)

Segment LCD drive

o LCD drive supported on all pins (common or segment)

o Operates in Deep-Sleep mode with 4 bits per pin memory

Serial communication

o Two independent run-time reconfigurable serial communication blocks (SCBs) with re-config-
urable 12C, SPI, or UART functionality

Timing and pulse-width modulation

o Four 16-bit Timer/Counter Pulse-Width Modulator (TCPWM) blocks

o Center-aligned, Edge, and Pseudo-random modes

o Comparator-based triggering of Kill signals for motor drive and other high-reliability digital
logic applications

Up to 36 programmable GPIOs

0 44-pin TQFP, 40-pin QFN, and 28-pin SSOP packages

o Any GPIO pin can be CapSense, LCD, analog, or digital

o Drive modes, strengths, and slew rates are programmable

PSoC Creator design environment

o Integrated development environment (IDE) provides schematic design entry and build (with
analog and digital automatic routing)
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o Applications Programming Interface (API) component for all fixed-function and programmable

peripherals

m Industry-standard tool compatibility
o After schematic entry, development can be done with Arm-based industry-standard develop-

ment tools

For more information see the CY8C42 family datasheet.

4.3.2 PSoC 5LP

An onboard PSoC 5LP is used to program and debug PSoC 4. The PSoC 5LP connects to the USB
port of the PC through a USB Mini B connector and to the SWD interface of the PSoC 4 device.

PSoC 5LP is a true system-level solution providing MCU, memory, analog, and digital peripheral
functions in a single chip. The CY8CS58LPxx family offers a modern method of signal acquisition,
signal processing, and control with high accuracy, high bandwidth, and high flexibility. Analog
capability spans the range from thermocouples (near DC voltages) to ultrasonic signals. For more
information, refer to the PSoC 5LP webpage.

Features
m 32-bit Arm Cortex-M3 CPU core

a
a

a

]

DC to 67-MHz operation

Flash program memory, up to 256 KB, 100,000 write cycles, 20-year retention, and multiple
security features

Up to 32-KB flash error correcting code (ECC) or configuration storage
Up to 64 KB SRAM

2-KB electrically erasable programmable read-only memory (EEPROM) memory, 1 M cycles,
and 20 years retention

24-channel direct memory access (DMA) with multilayer AHB bus access
a.Programmable chained descriptors and priorities
b.High bandwidth 32-bit transfer support

m Low voltage, ultra low power

a

a
a
a

Wide operating voltage range: 0.5 Vto 5.5V

High-efficiency boost regulator from 0.5 V input to 1.8 V to 5.0 V output

3.1 mA at 6 MHz

Low power modes including:

a.2-pA sleep mode with real time clock (RTC) and low-voltage detect (LVD) interrupt
b.300-nA hibernate mode with RAM retention

m Versatile /O system

[ T o o o |

a

28 to 72 1/0Os (62 GPIOs, 8 SIOs, 2 USBIOs)

Any GPIO to any digital or analog peripheral routability

LCD direct drive from any GPIO, up to 46x16 segments

CapSense support from any GPIO[3]

1.2V to 5.5 V I/O interface voltages, up to 4 domains

Maskable, independent IRQ on any pin or port

Schmitt-trigger transistor-transistor logic (TTL) inputs

All GPIOs configurable as open drain high/low, pull-up/pull-down, High-Z, or strong output
Configurable GPIO pin state at power-on reset (POR)

25 mA sink on SIO

m Digital peripherals

a
a
a

20 to 24 programmable logic device (PLD) based universal digital blocks (UDBs)
Full CAN 2.0b 16 RX, 8 TX buffers
Full-Speed (FS) USB 2.0 12 Mbps using internal oscillator
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o |

a

Four 16-bit configurable timers, counters, and PWM blocks

67-MHz, 24-bit fixed point digital filter block (DFB) to implement finite impulse response (FIR)
and infinite impulse response (IIR) filters

Library of standard peripherals
a.8-, 16-, 24-, and 32-bit timers, counters, and PWMs
b.Serial peripheral interface (SPI), universal asynchronous transmitter receiver (UART), and

c.Many others available in catalog

Library of advanced peripherals

a.Cyclic redundancy check (CRC)

b.Pseudo random sequence (PRS) generator

c.Local interconnect network (LIN) bus 2.0

d.Quadrature decoder

Analog peripherals (1.71V < VDDA <5.5V)

1.024 V £0.1% internal voltage reference across —40 °C to +85 °C
Configurable delta-sigma ADC with 8- to 20-bit resolution

Sample rates up to 192 ksps

Programmable gain stage: x0.25 to x16

12-bit mode, 192 ksps, 66-dB signal to noise and distortion ratio (SINAD), £1-bit INL/DNL
16-bit mode, 48 ksps, 84-dB SINAD, +2-bit INL, +1-bit DNL

Up to two SAR ADCs, each 12-bit at 1 Msps

Four 8-bit 8 Msps current IDACs or 1-Msps voltage VDACs

Four comparators with 95-ns response time

Four uncommitted opamps with 25-mA drive capability

Four configurable multifunction analog blocks. Example configurations are programmable
gain amplifier (PGA), transimpedance amplifier (TIA), mixer, and sample and hold

CapSense support

m Programming, debug, and trace

[ T [ B |

a

JTAG (4 wire), SWD (2 wire), single wire viewer (SWV), and TRACEPORT interfaces
Cortex-M3 flash patch and breakpoint (FPB) block

Cortex-M3 Embedded Trace Macrocell™ (ETM™) generates an instruction trace stream
Cortex-M3 data watchpoint and trace (DWT) generates data trace information
Cortex-M3 Instrumentation Trace Macrocell (ITM) can be used for printf-style debugging

DWT, ETM, and ITM blocks communicate with off-chip debug and trace systems via the SWV
or TRACEPORT

Bootloader programming supportable through 12C, SPI, UART, USB, and other interfaces

m Precision, programmable clocking

a

a
a
a
a

3- to 62-MHz internal oscillator over full temperature and voltage range
4- to 25-MHz crystal oscillator for crystal PPM accuracy

Internal PLL clock generation up to 67 MHz

32.768-kHz watch crystal oscillator

Low-power internal oscillator at 1, 33, and 100 kHz

For more, see the CY8C58LPxx family datasheet.
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Power Supply System

The power supply system on this board is versatile, allowing the input supply to come from the
following sources:

m 5-V power from onboard USB programming header J10

m 5-V to 12-V power from Arduino shield using J1.1 header

m VTARG - power from the onboard SWD programming using J6 or J7

m VIN-J11

The PSoC 4 and PSoC 5LP are powered with either a 3.3 V or 5 V source. The selection between
3.3V and 5V is made through the J9 jumper. The board can supply 3.3 V and 5 V to the I/O headers
and receive 3.3 V from the I/O headers. The board can also be powered with an external power
supply through the VIN (J11) header; the allowed voltage range for the VIN is 5V to 12 V. The LDO

regulator regulates the VIN down to 3.3 V. Figure 4-4 shows the power supply block diagram and
protection circuitry.

Note: The 5-V domain is directly powered by the USB (VBUS). For this reason, this domain is
unregulated.

Figure 4-4. Power Supply Block Diagram with Protection Circuits
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43.3.1

4.3.3.2

Protection Circuit

The power supply rail has reverse-voltage, over-voltage, short circuits, and excess current protection
features, as seen in Figure 4-4.

The Schottky diode (D4) ensures power cannot be supplied to the 5-V domain of the board from
the I/O header.

The series protection diode (D2) ensures VIN (power supply from the 1/0 header) does not back
power the USB.

The Schottky diode (D11) ensures 3.3 V from I/O header does not back power the LDO.

The series protection diode (D13) ensures that the reverse-voltage cannot be supplied from the
VIN to the regulator input.

A PTC resettable fuse is connected to protect the computer's USB ports from shorts and over-
current.

The MOSFET-based protection circuit provides over-voltage and reverse-voltage protection to
the 3.3-V rail. The PMOS Q1 protects the board components from a reverse-voltage condition.
The PMOS Q2 protects the PSoC from an over-voltage condition. The PMOS Q2 will turn off
when a voltage greater than 4.2 V is applied, protecting the PSoC 4.

The output voltage of the LDO is adjusted such that it takes into account the voltage drop across
the Schottky diode and provides 3.3 V.

Procedure to Measure PSoC 4 Current Consumption

The following three methods are supported for measuring current consumption of the PSoC 4
device.

When the board is powered through the USB port (J10), remove jumper J13 and connect an
ammeter, as shown in Figure 4-5.

Figure 4-5. PSoC 4 Current Measurement when Powered from USB Port

w‘»r‘
earal

When using a separate power supply for the PSoC 4 with USB powering (regulator output on the
USB supply must be within 0.5 V of the separate power supply).

o Remove jumper J13. Connect the positive terminal of voltage supply to the positive terminal of
the ammeter and the negative terminal of the ammeter to the lower pin of J13. Figure 4-6
shows the required connections.
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Figure 4-6. PSoC 4 Current Measurement when Powered Separately

Hardware

m When the PSoC 4 is powered separately and the PSoC 5LP is not powered, make these changes

to avoid leakage while measuring current:

o Remove the zero-ohm resistors R24 and R25. Removing these resistors will affect the USB-

[2C functionality.

o Remove R32, R33, and R34, which are meant for programming the PSoC 4. Removing these

resistors disables the PSoC 5LP capability for programming.

o Connect an ammeter between pins 1 and 2 of header J13 to measure current.

Figure 4-7. Zero-ohm Resistor Position

R25, R24 R32, R33, R34

Programming Interface

The kit allows programming and debugging of the PSoC 4 in two modes:

m Using the Onboard PSoC 5LP Programmer and Debugger
m Using CY8CKIT-002 MiniProg3 Programmer and Debugger
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435 Arduino Compatible Headers (J1, J2, J3, J4, and J12 - unpopulated)

This kit has five Arduino compatible headers; J1, J2, J3, J4 and J12. You can develop applications
based on the Arduino shield’s hardware.

Figure 4-8. Arduino Header

The J1 header contains I/O pins for reset, internal reference voltage (IOREF), and power supply line.
The J2 header is an analog port. It contains I/O pins for SAR ADC, comparator, and opamp. The J3
header is primarily a digital port. It contains 1/O pins for PWM, 12C, SPI, and analog reference. The
J4 header is also a digital port. It contains I/O pins for UART and PWM. The J12 header is an
Arduino ICSP compatible header for the SPI interface. This header is not populated. Refer to the “No
Load Components” section of A.6 Bill of Materials (BOM) on page 125 for the header part number.

Note: The PSoC 4 pin P0O[0] is connected to both pin 13 of the J2 header and pin 5 of the J4 header.
Similarly, the PSoC 4 pin P1[0] is connected to both pin 17 of the J2 header and pin 7 of the J4
header. Therefore, when using PO[0] or P1[0] from either the J2 or J4 header, there should not be
any external signal connected to the other header.
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Figure 4-9. Arduino Compatible Headers
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(J1-J4) Arduino Compatible Headers

4.35.1 Additional Functionality of Header J2

Hardware

The J2 header is a 9%2 header that supports Arduino shields. The port 0, port 1, and port 2 pins of
PSoC 4 are brought to this header. The port 1 pins additionally connect to the onboard CapSense
slider through 560-Q resistors. When the CapSense feature is not used, remove these resistors to

ensure a better performance with these pins.
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4.3.5.2

Functionality of Unpopulated Header J12

The J12 header is a 2x3 header that supports Arduino shields. This header is used on a small
subset of shields and is unpopulated on the PSoC 4 Pioneer Kit. Note that the J12 header only
functions in 5.0 V mode. To ensure proper shield functionality, ensure the power jumper is connected
in 5.0 V mode.

Digilent Pmod Compatible Header (J5 - unpopulated)

This port supports Digilent Pmod peripheral modules. Pmods are small I/O interfaces, which connect
with the embedded control boards through either 6- or 12-pin connectors. The PSoC Pioneer Kit
supports the 6-pin Pmod type 2 (SPI) interface. For Digilent Pmod cards, go to www.digilentinc.com.

This header is not populated on the PSoC 4 Pioneer Kit. You must populate this header before
connecting the Pmod daughter cards. Refer to the “No Load Components” section of A.6 Bill of
Materials (BOM) on page 125 for the header part number.

Figure 4-10. Pmod Connection
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Figure 4-11. Digilent Pmod Interface
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See A.2 Pin Assignment Table on page 120 for details on the pin descriptions for the J5 header.

437  PSoC 5LP GPIO Header (J8)

A limited set of PSoC 5LP pins are brought to this header. Refer to 6.3 Developing Applications for
PSoC 5LP on page 88 for details on how to develop custom applications. See A.2 Pin Assignment
Table on page 120 for pin details.

Figure 4-12. PSoC 5LP GPIO Header (J8)
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PSoC 5LP GPIO Extension Header

1/0 Header (J8)
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CapSense Slider

The kit has a five-segment linear capacitive touch slider on the board, which is connected to pins
P1[1] to P1[5] of the PSoC 4 device.

The modulation capacitor (Cmod) is connected to pin P4[2] and an optional bleeder resistor (R1) can
be connected across the Cmod. This board supports CapSense designs that enable waterproofing.

The waterproofing design uses a concept called shield, which is a conductor placed around the
sensors. This shield must be connected to a designated shield pin on the device to function. The
shield must be connected to the ground when not used. On the PSoC 4 Pioneer Kit, the connection
of the shield to the pin or to the ground is made by resistors R44 and R45, respectively. By default,
R45 is mounted on the board, which connects the shield to the ground. Populate R44 when
evaluating waterproofing designs, which will connect the shield to the designated pin, PO[1]. This
shield is different from the Arduino shields, which are boards that connect over the Arduino header.
Refer to the CapSense Design Guide for further details related to CapSense.

Figure 4-13. CapSense Slider
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Figure 4-14. CapSense Slider Connection
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CYB8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J 40


http://www.cypress.com/documentation/application-notes/an85951-psoc-4-and-psoc-analog-coprocessor-capsense-design-guide

o CYPRESS

~mg> EMBEDDED IN TOMORROW Hardware

439 Pioneer Board LEDs

The PSoC 4 Pioneer board has three LEDs. A green LED (D10) indicates the status of the
programmer. See A.5 Error in Firmware/Status Indication in Status LED for a detailed list of LED
indications. An amber LED (D3) indicates status of power supplied to the board. The kit also has a
general-purpose tricolor LED (D9) for user applications that connect to specific PSoC 4 pins.

Figure 4-15 shows the indication of all these LEDs on the board. Figure 4-16 and Figure 4-17 detail
the LED schematic.

Figure 4-15. Pioneer Kit LEDs
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Status LED RGB LED
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Fp0.3
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Figure 4-16. Status LED and Power LED
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Figure 4-17. RGB LED
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4.3.10

Push Buttons
The kit contains a Reset push button and a User push button, as shown in Figure 4-18.

The Reset button is connected to the XRES pin of PSoC 4 and is used to reset the onboard PSoC 4
device. The User button is connected to PO[7] of PSoC 4 device. Both the push buttons connect to
ground on activation (active low).

Figure 4-18. Push Buttons

nliﬁ..”:us.,':sri
Swi1
IXRES T—"h2
EVQ-PE105K 37
RESET
Sw2
PO 7 1:/ 2
EVQ-PE105K

USER BUTTON

PSoC 4 Reset User
Button

Note: The PSoC 4 Reset pin (XRES) has an internal pull-up resistor. However, an external pull-up
resistor R10 is connected to the PSoC 4 Reset pin on the kit, which is optional and required only in a
noisy system.
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The code examples described in this chapter introduce the functionality of the PSoC 4 device and
the onboard components. To access the examples, download the CD ISO image or setup files from
the kit webpage. After installation, the code examples will be available from Start > Kits on the
PSoC Creator Start Page. For a list of all code examples available with PSoC Creator visit PSoC 3/
PSoC 4/PSoC 5LP Code Examples webpage.

5.1 Using the Kit Code Examples

Follow these steps to open and program code examples:

1. Launch PSoC Creator from Start > All Programs > Cypress > PSoC Creator<version> >
PSoC Creator <version>.

2. On the Start page, click CY8CKIT-042 under Start > Kits. A list of code examples appears, as
shown in Figure 5-1.

Figure 5-1. Open Code Example from PSoC Creator

Start Page |
Learn
Getting Acquainted
New in 4.2
Mews and Informaticn

Start
Create New Project...
Cpen Existing Project...
Find Code Example ...
= Kits
= CYSCKIT-042
Blinking LED.cywrk
CapSense.cywrk
Deep Sleep.cywrk
PWM.cywrk

Recent

3. Build the code example by choosing Build > Build <Project name>. After the build process is
successful, a .hex file is generated.
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Figure 5-2. Build Code Example from PSoC Creator
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4. To program, connect the PSoC 4 Pioneer Kit to the computer using the USB cable connected to
port J10, as described in section 3.2 Programming and Debugging PSoC 4 on page 19. The
board is detected as KitProg.

5. Choose Debug > Program in PSoC Creator.

Figure 5-3. Program Device from PSoC Creator
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6. If the device is yet to be acquired, the Select Debug Target window will appear. Select KitProg/
<serial_number> and click Port Acquire, as shown in Figure 5-4.

Figure 5-4. Acquire Device from PSoC Creator

r ™
?
Select Debug Target - Llﬂ
=5 KitProg/1107055502274400
POWER =3
VOLTAGE_ADC = 4815
FREQUENCY = 2000000
PROTOCOL = SWD
KitProg Version 2.19
H
Show all targets '] ’ Port Setting ] I Port Acquire I
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7. After the device is acquired, it is shown in a tree structure below the KitProg/<serial_number>.

Now, click the Connect button.

Figure 5-5. Connect Device from PSoC Creator
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8. Click OK to exit the window and start programming.

Figure 5-6. Program Device from PSoC Creator
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Using the Micrium® pClProbe® Projects

The Micrium uC/Probe is a revolutionary software development tool that incorporates Micrium's pro-
prietary Graphical Live Watch to graphically visualize the internals of any embedded system. With
the uC/Probe, you can test your embedded design effortlessly, with a few mouse clicks. Cypress
provides pre-designed uC/Probe project (workspace) files for CapSense and PWM code examples
associated with the CY8CKIT-042 kit. These projects can be found in the kit installation directory in
the following folder:

<Install_Directory>\Cypress\CY8CKIT-042 PSoC 4 Pioneer Kit\1.0\uCProbe

Refer to section 6.5 Using uC/Probe Tool on page 107 for more details on how to use the Micrium
MC/Probe. To learn more about the uC/Probe, visit: micrium.com/tools/ucprobe/overview.

Note: To use the yC/Probe with PSoC Creator 4.2, the '-gdwarf-3' command line parameter should
be added in the code example under Build Settings, as shown in Figure 5-7.

Figure 5-7. Project Settings — Compiler Command Line Parameter

Build Settings ? b
Configuration: | Debug (Active) w
Toolchain: ARM GCC 5.4-2016-g2-update ~
& CYSCKIT_044_Sensor_Hub '~ Command Line
&-Code Generation Custom Flags -gdwarf-3
E-Debug

- Cystomizer

=-ARM GCC 54-2016-g2-upda
#-General
--Assembler
=+ Compiler

General

Optimization

- LITIKET

#-User Commands

Custom Flags
Allows you to enter a custom command line for the Compiler tool.

-mepu=cortex-ml -mthumb -1 -IGenerated_Source\PSoC4 -Wa.-alh=3{0utputDir}/
${CompileFile}.lst-g-D DEBUG -W all ffunction-sections ffat-lto-objects -Og -gdwarf-3
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5.3.2
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Blinking LED

Project Description
This code example uses a pulse-width modulator (PWM) to illuminate the RGB LED. The PWM out-

put is connected to pin PO_3 (blue) of the RGB LED. The frequency of blinking is set to 1 Hz with a

Code Examples

duty cycle of 50 percent. The blinking frequency and duty cycle can be varied by varying the period
and compare value respectively.

Note: The PSoC 4 Pioneer Kit is factory-programmed with this example.

Figure 5-8. PSoC Creator Schematic Design of Blinking LED Project

1]

PWM

PWM

ov
count un

(1 ——start cc

line
line_n

Clock[_———]clock

10 kHz

interrupt

oo}

Pin_BlueLED

_’__

Hardware Connections

No specific hardware connections are required for this example because all connections are hard-
wired on the board. Open Blinking LED.cydwr in the Workspace Explorer and select the suitable pin.

Table 5-1. Pin Connection

0

Pin Name

Port Name

Pin_BlueLED

PO_3 (Blue)

Figure 5-9. Pin Selection for Blinking LED Project

Vdd

uey’ Resistor_Blue

LED_BI

P4_VDD

MName

[ ] ‘ Pin BlueLED

Port

|PD[3] [:] 27

Lock

- N
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5.3.3 Flow Chart

Figure 5-10 shows the flow chart of code implemented in main.c.
Figure 5-10. Blinking LED Code Example Flow Chart

( Start )

Initialize and start the
PWM component

End

534 Verify Output

Build and program the code example onto the device. Observe the frequency and duty cycle of the
blinking LED. Change the period and compare value in the PWM component, as shown in
Figure 5-11. Rebuild and reprogram the device to vary the frequency and duty cycle.

Figure 5-11. PWM Component Configuration Window

Configure TCPWM_P4_v2_10° (-2 S
Name: PWM
Configuration -~ PWM |~ Built-in 1Pk
Prescaler: Input  Presert  Mode i
P coud| O \emeke |-
start W Lewvel -
PYWM mode: [Pwi - 2 Lev
stop | [sting edge -
Dead time cycle: 0 = awitch ] [sting 0 - e
Stop signal event: Dontstoponkil + count [Level -
Kill signal event: -
T domcxgos Register Swap RegisterBuf
Output line signal: Direct output - Period | 10000 [ [65535
Output line_n signal: Compare | 5000 [] |s5535 B

Intermupt
[ On teminal count

] On compare/capture count

| PWM, left aligned | !
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5.4 PWM

5.4.1 Project Description

This code example demonstrates the use of the PWM component. The project uses three PWM out-
puts to set the color of RGB LED on the Pioneer Kit. The LED cycles through seven colors — violet >
indigo > blue > green > yellow > orange > red (VIBGYOR). Each color is maintained for a duration of
one second. The different colors are achieved by changing the pulse width of the PWMs.

Figure 5-12. PSoC Creator Schematic Design of PWM Code Example

PWM_Red
PWM
P4 VDD

av
- Vdd

[ +———count unte)
O3 start cclo

" 22K
line —tBe.d.L.EP_Mr\_ I _H_ .

line_n (£ Resistor Red LED_Redfy’
clock

interrupt (=1

PWM_Green
PWM

ovIF]
[}+————count un e
T stant celo

_Pin GreenLED, "

1
1
"
j
1
1
1
'
'
'
1
1
1
'
'
'
1
1
1
I
'
ling ———fp——=--"=--= I— - —|— -
line_n Resistor_GreenLED_Gresfiy’ ,
1

1

'

'

'

1

1

1

'

'

'

1

1

1

'

'

I

Clock_PWM[__} clock
100 kkz interrupt =1

PWM_Blue
PWM

ov i+
[T}—————count unie
T |start cclo

Pin_BlueLED ¢

line [ N-BIWELED VWA= - - — - -
line_n [ Resistor Blue LED_Bluéy'

clock

interrupt (51

542 Hardware Connections

No specific hardware connections are required for this code example because all connections are
hard-wired on the board. Open PWM.cydwr in the Workspace Explorer and select the suitable pins.

Table 5-2. Pin Connections

Pin Name Port Name
Pin_RedLED P1_6 (Red)
Pin_GreenLED |PO_2 (Green)
Pin_BlueLED PO_3 (Blue)

Figure 5-13. Pin Selection for PWM Project

Mame Port Fin Lock
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54.3 Flow Chart
Figure 5-14 shows the flow chart of code implemented in main.c.
Figure 5-14. PWM Code Example Flow Chart

Initialize the colormap
for VIBGYOR

l

Initialize and start the
PWM components

>l

Wait for one second

:

Set the PWM widths to
get next color in the
color map

54.4 Verify Output

Build and program the code example, and reset the device. Observe the RGB LED cycles through
the following color pattern:

violet > indigo > blue > green > yellow > orange > red (VIBGYOR)
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5.5 Deep Sleep

5.5.1 Project Description

Code Examples

This code example demonstrates the low-power functionality of the PSoC 4. The LED is turned on
for one second to indicate Active mode; then, the device enters Deep-Sleep mode. When switch
SW2 is pressed, the device wakes up and the LED is turned on for one second and then goes back

into Deep-Sleep mode.

Figure 5-15. PSoC Creator Schematic Design of Deep-Sleep Project

Pin_WakeUpSwitch

sSw2 Pins
r-- __/_ _______ N S| SN .
| irq
J7 isr_WakeUp
Vss
552 Hardware Connections

_ Pin_RedLED

Resistor RED

K

LED_Rexd)

No extra connections are required for the code example functionality because the connections are
hard-wired onto the board. To make low-power measurements using this project, refer to the use

case detailed in section 4.3.3.2 Procedure to Measure PSoC 4 Current Consumption on page 34.

Open Deep Sleep.cydwr in the Workspace Explorer and select the suitable pin.

Table 5-3. Pin Connection

Pin Name Port Name
Pin_RedLED P1_6 (Red)
Pin_WakeUpSwitch PO_7

Figure 5-16. Pin Selection for Deep-Sleep Project

Mame Port Pin Lock
[ ]| Pin RedLED P1[&] 43
[ ]| pin_WakeUpSwitch PO [7] 31

Note that the Debug (SWD) port is disabled in the example to reduce power consumption during
Deep-Sleep power mode. The Debug port can be enabled by setting the Debug Select option to
SWD in the System tab of the .cydwr file, as shown in Figure 5-17. Disabling the debug port dis-
ables the ability to debug the code example through SWD.
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Figure 5-17. Enable Debug Select

Code Examples

Start Page ]/Tq:ﬂesg'\cysm)/ *Deep Sleep.cydwr ]

~ 4k X

- Device Configuration Mode

* Reset | Expand | L"E| Collapse
Option Value
=+ Configuration
Compressed N

Allow but warn

- Unused Bonded 10
- Heap Size (bytes) 0x0100
Stack Size (bytes) 0x0400

- Include CMSIS Core Peripheral Library Files

= Programming'.Debugging

SWD (serial wire debug)

.~ Chip Protection Open ~
E Operating Cenditicns
VDDA (V) 5.0
- WDDD (V) 5.0

- Wariable VDDA

device can still be acquired with SWD, and reprogrammed, but not for debugging. For mare information see the device datasheet or Technical Reference Manual (TRM).

Controls whether or not to reserve pins for debugging. f WD is selected, the debugging features of the chip will be extemally accessible.  GPIO is selected the pins are available for general purpose use. When set to GPIO the
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5.5.3 Flow Chart

Figure 5-18 shows the flow chart of code implemented in main.c.

Figure 5-18. Deep-Sleep Project Flow Chart

Start

Lo

4

Turn LED on
for one second

4

Enter Deep-
Sleep mode

4

Interrupt on
SW2 press

v

Clear the
interrupt

|

554 Verify Output

Build and program the code example, and reset the device. LED is on for one second and turns off,
which indicates that the device has entered Deep-Sleep mode. Press SW2 switch to wake up the

device from Deep-Sleep mode and enter Active mode. The device goes back to Deep-Sleep mode
after one second.

Note: When the device is in Deep-Sleep mode, the programmer must reacquire the device before
programming can start.
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5.6

5.6.1

5.6.1.1

CapSense

This code example can be executed in two ways — with and without CapSense tuning. The same
project can be used to demonstrate the CapSense functionality as well as CapSense tuning using
the Tuner Helper GUI in PSoC Creator. This is done by commenting and uncommenting the line
#define ENABLE_TUNER in the main.c file of the code example. PSoC Creator does not compile
the code under the #ifdef (if defined) statement when the #define statement is commented (/
* . */ or //). Similarly, when the #define statement is uncommented, the code required for work-

ing with Tuner GUI is compiled. By default, the project is set to work without CapSense tuning by
commenting the #define.

CapSense (Without Tuning)

Project Description

This code example demonstrates CapSense on PSoC 4. The example uses the five-segment
CapSense slider on the board. Each capacitive sensor on the slider is scanned using Cypress’s
CapSense Sigma Delta (CSD) algorithm implemented in the CapSense component. This project is
pre-tuned to take care of the board parasitics. For more information on the CapSense component
and CapSense tuning, see the CapSense component datasheet in PSoC Creator.

In this code example, the brightness of the green and red LEDs are varied, based on the position of
the user’s finger on the CapSense slider.

Figure 5-19. PSoC Creator Schematic Design of CapSense Code Example

EZI2C_1
EZI2C

Slave PWM
Pin_Red ED 2 !
CapSense ovlEl = - = - - = —— —AN— - - -4
CapSense CSO O +———count un =) LED R’ Fesistor Red ]
OF——start 24 S
line ——
Aule (SmanSense) line_n ——
Clock [———>clock
100kl interrupt{=
Pin_GreenLED LK [
b - el el —— AN - -
LED Grewg’ — Fesistor Gresn

Note: The EzI2C component is not used when tuning is disabled.
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5.6.1.2 Hardware Connections

No specific hardware connections are required for this code example because all connections are
hard-wired on the board. Open CapSense.cydwr in the Workspace Explorer and select the suitable
pins.

Table 5-4. Pin Connection

Pin Name Port Name
CapSense:Cmod P4 2
CapSense:Sns[0] P1_1
CapSense:Sns[1] P1_2
CapSense:Sns[2] P1_3
CapSense:Sns[3] P1_4
CapSense:Sns[4] P15
Pin_GreenLED PO_2 (Green)
Pin_RedLED P1_6 (Red)
EZI2C_1:scl P3_0 (SCL)
EZI2C_1:sda P3_1 (SDA)

Note: The 12C communication lines are not used when tuning is disabled.

Figure 5-20. Pin Selection for CapSense Code Example

Mame ! Port Pin
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5.6.1.3 Flow Chart

Figure 5-21 shows the flow chart of code implemented in main.c.

Figure 5-21. CapSense Project Flow Chart

Initialize and start the
PWM and CapSense
components

—

Scan the CapSense
slider

Get the finger position
on the slider

Y
Set the PWM output
width to adjust the
brightness of the RGB
LED

5.6.1.4  Verify Output

The brightness of the green and red LEDs are varied based on the position of the user’s finger on
the CapSense slider. When the finger is on segment 5 (P1[5]) of the slider, the green LED is brighter

than the red LED; when the finger is on segment 1 (P1[1]) of the slider, the red LED is brighter than
the green LED.
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5.6.2 CapSense (With Tuning)

5.6.2.1 Project Description
This code example demonstrates CapSense tuning on PSoC 4 using the "Tuner" to monitor
CapSense outputs. The CapSense outputs such as rawcounts, baseline, and signal (difference
count) can be monitored on the Tuner GUI. The project uses the auto-tuning feature, which sets all
CapSense parameters to the optimum values automatically. The parameter settings can be moni-
tored in the GUI but cannot be altered. In the manual tuning method, parameter settings can be
changed in the GUI and the resulting output can be seen.
The code example uses the five-segment CapSense slider on the board. Each capacitive sensor on
the slider is scanned using Cypress's CapSense Sigma Delta (CSD) algorithm implemented in the
CapSense component. The code uses tuner APIs. The tuner APl CapSense_TunerComm() is used
in the main loop to scan sensors, which also sends the CapSense variables RawCounts, Baseline,
and Difference Counts (Signal) to the PC GUI through 12C communication.
In this example, the brightness of the green and red LEDs are varied, based on the position of the
user's finger on the CapSense slider.
See Figure 5-19 for the project schematic.

5.6.2.2 Hardware Connections

No specific hardware connections are required for this code example because all connections are
hard-wired on the board. Open CapSense.cydwr in the Workspace Explorer and select the suitable
pins.

See Table 5-4 and Figure 5-20 for the CapSense project pin connections.
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5.6.2.3 Flow Chart
Figure 5-22. CapSense with Tuning Flow Chart

Start
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5.6.2.4 Launching Tuner GUI

The Tuner GUI from PSoC Creator should be up and running for the code example to work. To
launch the GUI follow these steps:

1. Go to the project's TopDesign.cysch file.
Figure 5-23. Top Design File

Workspace Explorer (1 project) > X
& g

B ‘workspace 'CapSense’ (1 Projects) -
ElEl Project 'CapSense’ [CYBCA24580]-483]

>_\|9 CapSense.cydwr

=+ ¢ Header Files

T 0
t..|h] deviceh _§
B+ Source Files =
B i
t|g] main.c 2l

2. To open the tuner, right-click on the CapSense_CSD component in PSoC Creator and click
Launch Tuner.
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Figure 5-24. Launch Tuner

Cut Ctrl+X

&
|53 Copy Ctrl+C
T4 Paste Ctrl+V
1% Delete Del
Select All Ctrl+A

Zoom 3

Shape »

Configure...
Disable

is project on
anges co aﬁ Open Datasheet ... o f

Find Example Project...
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Launch Tuner

Generate Macro
Show in analog editor
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3. The Tuner GUI opens. Click Configuration to open the configuration window.

Figure 5-25. Tuner GUI

File View Debug Validation Tools u| Help
Bigy Start | § Stop "|# @ Logging ‘ Revert Parameters
Tuning |~ Graphing / Validation |~ Debugaging |Sensm Properties > 1 X
|#] Reset Widgets Layout | [LinearSIiderﬂ_eD_LS -
LinearSlider) SMR: Max value: 255
250
1 2 3 4
200
150
Finger Thre_shold 100
Noise Threshold 50
o]
Modulation IDAC 2
20
4
2
88
Noise th 44
Scan resolution 14 bits
|DAC range IDAC _4&x
Sensor Pro... |Graphing P| Logging Pr... |
_ Speed: | Desired packet size: 57 (0x39)| | Logging is OFF .:

4. Set the 12C communication parameters, as shown in the following figure.

Figure 5-26. 12C Communication

-
Tuner Communication Setup M
Parts: Part Corfiguration
KitProg/1D0E192D00232400 - I12C [2C address: &
Communications Port (COM1) - UART Sub-address: ’2—E)l‘tes -
KitProg USB-UART (COME) - UART 12C Speed
) 1 MHz
@ 400kHz
) 100kHz
Port Information ) 50kHz
KitProg Version 2.20
[ ok || Cance
b

5. Click OK to apply the settings.
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5.6.2.5  Verify Output

1. To start the scanning and communication process, click Start.
Figure 5-27. Start Communication

File  View Debug Validation Tools a| Help
1@ Ll Stop |Ea Cenfiguration | @ Logging | Revert Pararneters
" Tuning |’ Graphing ]/\u'alidaton ]/Debugging ] |Sensol Properties -~ 0 x
2] Reset Widgets Layout | LinearSlider0_e0__LS -
LinearSlider0 SMNR: Max value: 255
250
1 2 £ 4
200
150
Finger Thre_shold 100
Noise Threshold 50
a
Modulation IDAC A
20
4
2
23
44
14 bits
IDAC range IDAC_4x
Sensor Pro... |Graphing P| Logging Pr... |
_ Speed: Desired packet size: 57 ((x39) | 12C Address: 8 3
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2. Select a sensor in the Tuning tab. A red outline is seen on the selected sensor. Different
CapSense parameters are shown in Sensor Properties tab on the bottom-right. You cannot edit

the settings because auto-tuning is used in this project; auto-tuning automatically sets all the

parameters. Touch the selected sensor and observe the response in the tuner window.

Note: The board is designed according to layout guidelines for CapSense (best practices) for

1.5-mm overlay. Therefore, it is recommended that an overlay (not shipped with the kit) be used

while using the CapSense code example with tuning.

Figure 5-28. Sensor Tuning

File  View Debug Validation Tools n| Help
Start |ﬂ Stop | |§ Configuration | @ Logging Revert Pararneters
g Tuning >Graphing Validation " Debugging Sensor Properties >3 X
Reset Widgets Layout | LinearSliderl_e0__LS V]
LinearShider() SMR: - 4411 Max value: 255
250
) 1 2 3 4
200
&
H
150
Fin reshold 100
Moi reshald 50
a
Modulation [DAC 2
C on |DAC 20
2
23
14 bits
IDAC range IDAC_4x
éensor Pro..’Graphing P...|Logging Pr...
Running Speed: 45 pkts/s| Desired packet size: 57 (0:39) | 2C Address: &

3. In the Graphing tab, the CapSense results: Raw counts, Baseline, Signal (difference count) and
On/Off status for each sensor are represented as a graph. Click the Graphing Properties tab on

the bottom-right to select the slider element for which the CapSense results are to be shown in

the Graphing tab.
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4. Select the sensor parameters to observe, as shown in the following figure. The graph of the
selected parameters is shown.

Figure 5-29. Sensor Parameter Graph
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5. Touch a sensor or slider element and see the increase in raw counts.
Figure 5-30. Raw Count Increase
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6.1 Using PSoC 5LP as a USB-UART Bridge

The PSoC 5LP serves as a USB-UART bridge, which can communicate with the COM terminal
software. This section explains how to create a PSoC 4 code example to communicate with the
COM terminal software. This project is available with other code examples for the PSoC 4 Pioneer
Kit at the element14 webpage, 100 Projects in 100 days.

Users who have a Windows operating system that does not have HyperTerminal can use an

alternate terminal software such as PuTTY.

1. Create a new CY8CKIT-042 (PSoC 4200) Kit project in PSoC Creator, as shown in the following
figures. Select a specific location for your project and name the project as desired. You must
select the appropriate target hardware (kit) for this project. Ensure that the Select project tem-
plate option is set to ‘Empty schematic’. This example uses PSoC 4200 as the target device and
CY8CKIT-042 as the target board.

Figure 6-1. Select Project Type
[ Create Project - CYBCKIT-042 (PSoC 4200) l 7 |-t )

Select project type
Choose the type of project - design, library, or workspace.

Design project:
@ Tanget kit: CYBCKIT-042 (PSoC 4200) -

() Target module:
() Target device:
(2 Library project

() Workspace

Next > ] [ o
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Figure 6-2. Select Empty Schematic Option

.
Create Project - Last used: CYSCKIT-042 (PSoC 4_ [

Select project template
Choose a schematic template or start your design with a kit or example project.

m Code example
10| (Choose from our library of code examples.

== | Pre-populated schematic
= |Start with typical MCU functions {ike UART, ADC, etc ).

Empty schematic
Create a full custom design by adding functionality from the component catalog.

Figure 6-3. Create Project

-
Create Project - CYBC4245AXI1-483

Create Project

Choose a name and location for your design.

Workspace: Create new workspace

Worspace name:  Waorkspacell

Location: C::\Users‘saga'\Documents'\saga D
Project name: Design1
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2. Drag and drop a UART (SCB) component to the top design.
Figure 6-4. UART Component Under Component Catalog

Component Catalog (151 components) > o X
0] |
ﬁ Search for...

~ Cypress [© Off-Chip 4 b
| Cypress Component Catalog

-]g Analog

-Iﬁ Capbense
E}]ﬂ Communications
e 12C
FHeg 125
-[#] LIN [v4.0]
{2 SENTTX [v1.0]
[%] Serial Communication Block (SCB) [v4.0]
BHeg SMBus/PMBus Slave
(%] Software Transmit UART [+1.50]
&g SPI
R UART (5CB moce) 1401
{2 UART [v2.50]
B-&g Digital
[FH&a Diselav

Advanced Topics

3. To configure the UART, double-click or right-click on the UART component and select Configure.

Figure 6-5. Open UART Configuration Window

Ctrl+X
Copy Ctrl+C
Delete Del
Select All Ctrl+A
Zoom 3
Shape 3
Configure..,

‘51“' Open Datasheet ...

4. Change the component name from UART_1 to UART.
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5. Configure the UART as shown in the following figures.

Figure 6-6. UART Configuration Window
Configure 'SCB_P4_v4_0' — EER)

Name: UART]

Configuration | UART Basic [ UART Advanced | UART Pins | Builtin | 4P

() Unconfigured SCB
O

=iy

& SPI

@ UART

o ) m [ ow ]

Figure 6-7. UART Basic Configuration Window

Configure 'SCB_PA4_v4 0 — IR
Name: UART
Configuration,” UART Basic [ UART Advanced | UART Pins | Builtin | 4 b
Mode:
Direction:

s

Baud rate (bps): »  Actual baud rate {bps): UNKNOWHN (Press "Apphy™)

Data bits:
o
Stop bits:
Crwversampling: 12 =

[ Clock from teminal
[ Median fiter
Retry on MACK
Inverting RX
[C] Enable wakeup from Deep Sleep Mode

Low power receiving

s ) o]
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Figure 6-8. UART Advanced Configuration Window
Canfigure 'SCB_P4.v4.0 o — )

Name: UART
Configuration | UART Basic  UART Advanced | UART Pins - Buit-n 40
Buffers size Intermupt DMA
R buffer size: |8 @ MNone [ ] RX output
TX buffersize: |8 ) Intemal [ TX output fl
["] Byte mode @ Bdemal
Intemupt sources
["] UART done [ RX FIFO not empty i
[] T FIFG not ful (] R FIFD full i
] T% FIFO empty [ RX FIFO overflow f
[] TXFIFO averflow ["] RX FIFO underfiow
[] TX FIFO underlow ["] Rxframe amor
[] TXlost arbitration ["] RX parity ermor
[] T*NACK [] RXFIFO level
[] TXFIFO level [] Break detected ~ Ereak width:
FIFO levels
[ Muttiprocessor mode R FIFO drop
I Address (hex) [ On pariy emor
Yook = | Onfra
I Mask (hex): me emor
: [] Accept matching address in RX FIFO
L Fow control
| B el =
Il Ors Polarity RTS FIFO level: I
| Do sy
|
_e———

6. Click Apply and then OK to save the changes made to UART configuration.
7. Select P0[4] for UART RX and PO[5] for UART TX in the Pins tab of <Project.cydwr>.

Figure 6-9. Pin Selection

MName 4 Port Pin Lock
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8. Place the following code in your main.c project file. The code will echo any UART data received.

int mainQ)
uint8 ch;

/* Start SCB UART TX+RX operation */
UART_Start();

/* Transmit String through UART TX Line */
UART_UartPutString("'CY8CKIT-042 USB-UART'™);

for(::)
. /* Get received character or zero if nothing has been received yet
! ch = UART UartGetChar();
if(Ou '= ch)
/* Send the data through UART. This functions is blocking and waits until

there i1s an entry into the TX FIFO. */
UART_UartPutChar(ch);
}

3 }
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9. Build the project by clicking Build > Build {Project Name} or [Shift] + [F6]. After the project is
built without errors and warnings, program (by clicking Debug > Program) the project to PSoC 4
through the PSoC 5LP USB programmer or MiniProg3.

Connect the RX line of the PSoC 4 to J8.10 and TX line of the PSoC 4 to J8.9, as shown in the
following figures.

Figure 6-10. UART Connection Between PSoC 4 and PSoC 5LP

Figure 6-11. Block Diagram of UART Connection Between PSoC 4 and PSoC 5LP

J8.9  Js.10 PO[4] PO[5]
P1216]  P12[7] UART RX UART TX

UART RX UART TX

USB D+ P15[6]
Mini B — ot PSoC 5LP PSoC 4

Note: UART RX and UART TX can be routed to any digital pin on PSoC 4 based on the configura-
tion of the UART component. An SCB implementation of UART will route the RX and TX pins to
either one of the following subsets: (PO[4], PO[5]) or (P3[0],P3[1]) or (P4[0],P4[1]).
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To communicate with the PSoC 4 from the terminal software, follow this procedure:

1. Connect USB Mini B to J10. The kit enumerates as a KitProg USB-UART and is available under
the Device Manager, Ports (COM & LPT). A communication port is assigned to the
KitProg USB-UART.

Figure 6-12. KitProg USB-UART in Device Manager

=y Device Manager l = (=] ﬂ

File Action View Help
e | o HE "

> - Computer -
> -y Disk drives

> B Display adapters

> 243 DVD/CD-ROM drives —
> Uﬁ Human Interface Devices

> g IDE ATASATAPI controllers

:> - a IEEE 1394 Bus host controllers
b ’—ﬁ Imaging devices

» == Keyboards

> - ¥ Mice and other pointing devices

'> A Monitors

4 "‘ Network adapters

: L Cisco Systems VPN Adapter for 64-bit Windows

_'." Intel(R) 82579LM Gigabit Network Connection

¥ Intel(R) Centrino(R) Advanced-N 6205

"‘ Microsoft Virtual WiFi Miniport Adapter

A ,@ Other devices

: -|1% Unknown device

4 ?’ Ports (COM & LPT)

? Intel(R) Active Management Technology - SOL (COM3)
2T KitProg USB-UART (COM12
:> n Processors

> -[1¥ Security Devices

> - SM Driver

i “_"3* Sound, video and game controllers
> 4z Storage controllers

o System devices

b - ﬂ Universal Serial Bus controllers m

m
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2. Open HyperTerminal and select File > New Connection and enter a name for the new connec-
tion and click OK.

For PuTTY, double-click the putty icon and select Serial under Connection.

Figure 6-13. Open New Connection
HyperTerminal

Connection Description P X

p

New Connection

Enter a name and choose an icon for the connection:

Mame:
USB-UART communication|

lcon:
< 11 | 3
[ OK J l Cancel
PuTTY
#R PuTTY Configuration M
Category:
|T:|--S_essicn Basic options for your PuTTY session
. -Logging . N
& Teminal Specify the destination you want to connectto
--Keyboard Host Name (or IP address) Port
- Bell 22
[—:|--".|'1..f"i-r1Fdeoa\:ures Connection fype: B B B
| JRaw () Telnet () Rlogin @ SSH ) Serial
--Appearance
-~ Behaviour Load, save or delete a stored session
- Translation .
- Salaction Saved Sessions
- Colours
[=-Connection D -
efault Settings
. Data g Load
Teine T
et
elete
o
- Serial
C_Iose window on exit B
) Always ) Never @) Only on clean exit
o) [
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3. A new window opens, where the communication port can be selected.
In HyperTerminal, select COMX (or the specific communication port that is assigned to KitProg

USB-UART) in Connect using and click OK.
In PuTTY enter the COMX in Serial line to connect to.
This code example uses COM12.

Figure 6-14. Select Communication Port

HyperTerminal

-

Connect To

P |

Area code: 0a0

Bhone number:

USB-UART communication

Enter details for the phone number that you want to dial:

Country/region: India (97)

Connect using: [COM12

7]

OK l [ Cancel l

h

PuTTY

@ PuTTY Configuration

Category:

=-Session

¢ L Logging
E;]--Terminal

- Keyboard
. Bell

- Features
=-Window

- Appearance
- Behaviour
- Translation
- Selection
- Colours
=-Connection

. Data

- Proxy

- Telnet

- Rlogin
[#-35H

- Serial

Options controlling local serial lines
Selecta serial line

Seral line to connectto comi2

Configure the serial line

Speed (baud) 9600
Data bits 8
Stop bits 1

paty
Flow control XOMN/MXOFF -

Open ] l Cancel
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4. In HyperTerminal, select 'Bits per second', 'Data bits', 'Parity', 'Stop bits', and 'Flow control' under
Port Settings and click OK.

Make sure that the settings are identical to the UART settings configured for PSoC 4.

In PUTTY select 'Speed (baud)', 'Data bits', 'Stop bits', 'Parity' and 'Flow control' under Configure
the serial line. Click Session and select Serial under Connection type.

Serial line shows the communication port (COM12) and Speed shows the baud rate selected.
Click Open to start the communication.

Figure 6-15. Configure the Communication Port
HyperTerminal

COM12 Properties l B
Port Settings

Bits per second: [96{}0 v]

Data bits: [8 v]

Parity: [None V]

Stop bits: [1 ~

Flow control: [None V]

Restore Defaults

[ ok || cancet || apply |

PuTTY

@ PuTTY Configuration ﬁ

Category:

[=-Session Options controlling local serial lines
. © Logging
=~ Terminal
- Keyboard Serial line to connectto comMi2
- Bell
Features Configure the serial line
=-Window
- Appearance
- Behaviour Data bits 8
Translation
- Selection Stop bits
-Colours

- Comacior ey

- Proxy
- Telnet
- Rlogin
[H-S5H

Select a serial line

Speed (baud) 9600

—_

T
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Figure 6-16. Select Communication Type in PUuTTY

ﬁ PuTTY Configuration

5

= Terminal

- Keyboard
. Bell

- Features
=-Window

- Appearance
- Behaviour
- Translation
- Selection
- Colours
[=-Connection
..Data

- Proxy

- Telnet

- Rlogin
[#-SSH

- Serial

Basic options for your PuTTY session
Specify the destination you want to connectto

Serial line Speed
Ccomi2 9600

Connection type: ) )
_JRaw () Telnet [ Rlogin [ 1SSH

Load, save or delete a stored session

Saved Sessions

Default Settings Load

Save

i

Delete

Close window on exit
() Always (I Never @) Only on clean exit

[ open || cancel |

Advanced Topics

5. Enable Echo typed characters locally under File > Properties > Settings > ASCII Setup, to
display the typed characters on HyperTerminal. In PuTTY, enable the Force on under Terminal >

Line discipline options to display the typed characters on the PuTTY.

Figure 6-17. Enabling Echo of Typed Characters in HyperTerminal

-

ASCII Setup

2 - |

ASCIl Sending

[] send line ends with line feeds

iﬁcho typed characters Iocally‘?l

Line delay: 0

Character delay: 0

ASCIl Receiving

milliseconds.

["] Append line feeds to incoming line ends
[] Force incoming data to 7-bit ASCII
Wrap lines that exceed terminal width

milliseconds.

|| cancel
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Figure 6-18. Enabling Echo of Typed Characters in PuTTY

Open l I Cancel

#® PUTTY Configuration ﬁ
Category:
5--5‘;:ession Options controlling the terminal emulation
-Lo. 109 Setvarious terminal options
Terminal
~Keyboard [#] Auto wrap mode initially on
- Bell || DEC Origin Mode initially on
- Features [ |Implicit CR in every LF
E‘]"\”‘_'__'_’f;:;arame [ implicit LE in every CR
. Behaviour Use background colour to erase screen
- Translation ["|Enable blinking text
- Selection Answerbackto "E:
- Colours PUTTY
[=-Connection
~Data Line discipline options
- Proxy
. Telnet Local echo: .
- Rlogin () Auto (") Force oft
[+-SSH L_ocal line editing: ) B
.. Serial @) Auto (_)Force on (" Force off
Remote-controlled printing
Erinter to send ANSI printer output to:
MNone (printing disabled) -
|

Advanced Topics

6. The COM terminal software displays both the typed data and the looped back data from the
PSoC 4 UART.

Figure 6-19. Data Displayed on HyperTerminal

® | USB-UART communication - HyperTerminal

File Edit View Call Transfer Help

(== 2 DB &

CYBCKIT-042 USB-UART PPSSooCC_

Connected 0:00:36

Auto detect 9600 8-N-1

NUM

CY8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J

77



o CYPRESS

-~ EMBEDDED (N TOMORROW Advanced TOpiCS

Figure 6-20. Data Displayed on PuTTY

£ COM12 - PuTTY ST

CY8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J 78



o CYPRESS

~mg> EMBEDDED IN TOMORROW Advanced Topics

6.2 Using PSoC 5LP as USB-I2C Bridge

The PSoC 5LP serves as a USB-I12C bridge, which can be used to communicate with the USB-12C
software running on the PC. This project is available with other code examples for the PSoC 4 Pio-
neer Kit at the element14 webpage, 100 Projects in 100 days.

The following steps describe how to use the USB-12C bridge, which can communicate between the
BCP and the PSoC 4.

1. Create a new CY8CKIT-042 (PSoC 4200) Kit project in PSoC Creator, as shown in the following
figures. Select a specific location for your project and name the project as desired. You must
select the appropriate target hardware (kit) for this project. Ensure that the Select project tem-
plate option is set to ‘Empty schematic’. This example uses PSoC 4200 as the target device and
CYB8CKIT-042 as the target board.

Figure 6-21. Select Project Type
[ Create Project - CYSCKIT-042 (P5oC 4200) I. 2 ﬁr

Select project type
Choose the type of project — design, library, or workspace.

Design project:
@ Target kit: CYBCKIT-042 (FSoC 4200) ~

_ Target module:
") Tanget device:
_ Library project

) Workspace

Next > ] l —
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Figure 6-22. Select Empty Schematic Option

Select project template
Choose a schematic template or start your design with a kit or example project.

n101| |Code example
nn1n||Choose from our library of code examples.

== | Bre-populated schematic
= Start with typical MCU functions {ike UART, ADC, etc ).

Empty schematic
Create a full custom design by adding functionality from the component catalog.

Figure 6-23. Create Project

-
Create Project - CY8C4245AX1-483

Create Project

Choose a name and location for your design.

Workspace: Create new workspace

Workspace name: Workspacel1
Location: C:A\Users'saga \Documentszaga B

Project name: Design01
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2. Drag and drop an 12C component to the top design.
Figure 6-24. 12C Component in Component Catalog

Component Cataleg (151 components) * 1 X

| e

ﬂ Search for...

Cypress }/DFF—Chip l 4 I
Cypress Component Catalog
8§ Analog
+-88 CapSense
EH8g Communications
s 120
: Iﬁ EZI2C Slave (SCB mode) [v4.0]
Y 2C 508 mose) (401
g 125
(@] LIN [w4.0]
| Zlh SENT TX [v1.0]
-[#] Serial Communication Block (SCE) [v4.0]
F-8& SMBus/PMBus Slave
-[#] Software Transmit UART [v1.50]
Heg SPI
(2} UART [SCB mode) [v4.0]
| S UART [v2.50]

3. To configure the 12C component, double-click or right-click on the 12C component and select
Configure.

Figure 6-25. Open 12C Configuration Window
i #:

- & Cut Ctrl+X

-as"n Copy Cirl+C

Th| Pa Ctrl+

)( Delete Del
Select All Ctrl+A
Zoom ¥
Shape 3
Configure...
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4. Change the component name from 12C_1 to 12C.

5. Configure the 12C with the following settings.
Figure 6-26. 12C Configuration Tab

Advanced Topics

Configure 'SCB_P4 v4 0

Mame: 12C

Configuration | 12C Basic | 12C Pins | Builtdn |

q b

) Uncorfigured SCB
@ 12c

© EZI2C
© 5P
@ UART

-

/|

Apply

A

Figure 6-27. 12C Basic Tab

~
Configure 'SCB_P4_v4 0’ = - (2 [
Name: 12C
Configuration /12 Basic | 12C Pins | Builtin | q b
Mode: [Slave ']
Data rate (kbps): M0 «  Actual data rate (kbps): UNKNOWN (Fress "Apply”}
Oversampling factor 16 = Low: |8 = High: (8 =
Manual oversample control
[ Clock from teminal
Byte mode
Address RAW
Slave address (Pbits): <08 o fofofrfofofofx
MSE L38
Slave address mask: xFE |‘I— |1— |1— |1— |1— |‘I— |‘I— |F
[] Accept matching address in R FIFO
[] Azcept general call address
[] Enable wakeup from Deep Sleep Mode |
) e |
b
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Figure 6-28. 12C Advanced Tab

.
Configure 'SCB_P4_v4 (' — (-2 [
Name: 12C
Configuration | 12C Basic / I2C Pins | Builtin | 4 b

[ Show 12C terminals

Slew rate: Fast A

Co ) mm [ o ]|

Faw e o

6. Click Apply and then OK to save the changes.
7. Select pin P3[0] for the 12C SCL and pin P3[1] for the 12C SDA in the Pins tab of <poject.cydwr>.

Figure 6-29. Pin Selection

Mame Port Pin Lock

8. Place the following code in your main.c project file. The code will enable the PSoC 4 device to
transmit and receive 12C data to and from the BCP application.

int mainQ)

{

uint8 wrBuf[10]; /* 12C write buffer */
uint8 rdBuf[10]; /* 12C read buffer */
uint8 indexCntr;
uint32 byteCnt;

/* Enable the Global Interrupt */
CyGlobalIntEnable;

/* Start 12C Slave operation */
12C_Start();
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/* Initialize write buffer */
12C_I12CSlavelnitWriteBuf((uint8 *) wrBuf, 10);
/* Initialize read buffer */
12C_I12CSlavelnitReadBuf((uint8 *) rdBuf, 10);

for(;;) /* Loop forever */
{

/* Wait for 12C master to complete a write */
iT(Ou = (12C_l2CSlaveStatus() & 12C_12C_SSTAT_WR_CMPLT))
{

/* Read the number of bytes transferred */
byteCnt = 12C_I2CSlaveGetWriteBufSize();

/* Clear the write status bits*/
12C_l12CSlaveClearWriteStatus();

/* Move the data written by the master to the read buffer so that the
master can read back the data */
for(indexCntr = 0; indexCntr < byteCnt; indexCntr++)

{
rdBuf [indexCntr] = wrBuf[indexCntr]; /* Loop back the data to the read
buffer */
}

/* Clear the write buffer pointer so that the next write operation will
start from index 0 */
12C_I12CSlaveClearWriteBuf();

/* Clear the read buffer pointer so that the next read operations starts
from index 0 */
12C_I12CSlaveClearReadBuf();
}
/* If the master has read the data , reset the read buffer pointer to 0O
and clear the read status */
iT(Ou = (l12C_l2CSlaveStatus() & 12C_12C_SSTAT_RD_CMPLT))
{
/* Clear the read buffer pointer so that the next read operations starts
from index 0 */
12C_I12CSlaveClearReadBuf();

/* Clear the read status bits */
12C_l12CSlaveClearReadStatus();
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6. Build the project by clicking Build > Build Project or [Shift]+[F6]. After the project is built without
errors and warnings, program ([Ctrl]+[F5]) this code onto the PSoC 4 through the PSoC 5LP pro-
grammer or MiniProg3.

7. Open the BCP from Start > All Programs > Cypress > Bridge Control Panel <version num-
ber>.

8. Connect to KitProg/<serial_number> under Connected 12C/SPI/RX8 Ports.
Figure 6-30. Connecting to KitProg/<serial_number> in BCP

ﬁ Bridge Control Panel
File Editor Chart Execute Tools Help
FRE SR oL ERERE

Editor |Chart | Table | File |

4

Select Port in the PortlList, then try to connect
Opening Port

Successfully Connected to KitProg/1A19172E03242400
KitProg Version 2.02

L T T P roers [T B T PITS ' e

BXR Png
. Power Protocol

Send all stri A19172E03242400 _

I @® Reset ll B List " § Send ‘ bl L : Q@ 12
Repeat count L=

[=] | F¥ Repeat ” = Tofile ‘ p

Scan period. ms: =

| 1:1 | Syntax: 0K | | Connected || Powered | vottage: 3227 mv

9. Open Protocol Configuration from the Tools menu and select the appropriate 12C Speed.
Make sure the 12C speed is the same as the one configured in the 12C component. Click OK to
close the window.
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Figure 6-31. Opening Protocol Configuration Window in BCP
ﬁ Bridge Control Panel
File Editor Chart Execute
sEE E2R Sk ES

Editor | Chart | Table | File 12C Bootloader F3
I

sPI | RX8 (UART)|
12C Speed
©) 1MHz €@ 400kHZY ) 100kHz () 50kHz

G

10.From the BCP, transfer five bytes of data to the I12C device with slave address 0x08. The log
shows whether the transaction was successful. A '+' indication after each byte indicates that the
transaction was successful and a '-' indicates that the transaction was a failure.

Figure 6-32. Entering Commands in BCP

ﬁBr\dgeComro\ Panel =]
File Editor Chart Execute Tools Help

FREERR QEEER

W(8)X00 01 02 03 04(p)

Generates Stop condition
on 2Cbus
Data bytes
Slave address
"write data"” command
{ Indicates Acknowled (ACK) }
Sele¢t Port in the Portlist, then try to connect 2

Opening Port

Successfully Connected to KitProg/1A19172E03242400
KitProg Version 2.02

w 08%) 00+ 01+ 02+ 03+ 04+ p

Connected [2C/SPI/RX8 Ports

Power Protocol
Send all sti KitProg/1A19172E03242400 - _
[@Reset | st | Boea | T J e E Qe
Repeat count: ep
s T Repeat | 5 Tofle o
_ Scan period, ms e

o

[1:21 [ syntax: 0 [ok | Gonnecied [Rogied votage: 3325 mv
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Figure 6-33. NACK Indication in BCP

ﬁ Bridge Control Panel =

File Editor Chart Execute Tools Help
BEWARR OEEEER
Editor | Chart | Table | File

w 700 01 02 03 04 p

Indicates Not acknowledged (NACK)

4

Selegt Port in the PortList, then try to connect
Opening Port

Successfully Connected to KitProg/1219172E03242400
KitProg Version 2.02

w 081 00+ 01+ 02+ 03+ 04+ p

w 072) 00- 01- 02- 03- 04- p

Connected [2C/SPI/RX8 Ports:

7 Protocol
Sendall sti KitProg/1A19172E03242400 ~
[@Reset | Bt [ Foaa | o R @i
Repeat count 0% 5P
[ Stop | § Repeat | 15 Tofle comig

Scan period, ms: 0

| 1:21 I Syntax: OK |ok --Votage: 3327 mv

11.From the BCP, read five bytes of data from the 12C slave device with slave address 0x08. The log
shows whether the transaction was successful.

Figure 6-34. Read Data Bytes from the BCP

B Bridge Conared Panel (] -
Eile Editor Chant Execute Tools Help
FHERen oL EBEE

Ediot | Chat | Table | Fils

Generates Stop condition
on 12 bus

Mo. of data bytes to read
x - Reserved symbaol, which means that 1 byte of
data should be read

Slave address

“read data” command
Data bytes read from the slave device

Selact Port in the PortList, then try to connect
lopening Port
Fully C d to KitProg/lA19%172E03242400
KitProg Version|2.02

w 08+ 00+ 01+ 02+ 03+ 04+ p

w 07- 00- 01- = - 04- p

r 08 + 01+ 02+ 03+ O

Connacted RSP Pors

- ; Puwer Prakeal
T T Send all swings:
© Reset | B Lst T Sand wu! Ak e
= [
= P Repeat | B Totle i
Scan period, ms [ )
[1:16 [ syomax:0x Jok SR ISR vorooe: 3327w

Note: Refer Help Contents under Help in BCP or press [F1] for details of I2C commands.
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6.3 Developing Applications for PSoC 5LP

The PSoC 4 Pioneer Kit has an onboard PSoC 5LP whose primary function is that of a programmer
and a bridge. You can build either a normal project or a bootloadable project using the PSoC 5LP.

The PSoC 5LP connections in the Pioneer board are summarized in Figure 6-35. J8 is the 1/0 con-
nector (see section 4.3.7 PSoC 5LP GPIO Header (J8)). The USB (J10) is connected and used as
the PC interface. But you can still use this USB connection to create customized USB designs.

The programming header (J7) is meant for standalone programming. This header needs to be
populated. See the 'No Load Components' section in A.6 Bill of Materials (BOM) on page 125.

Figure 6-35. PSoC 5LP Block Diagram

D+
P15_6
Mini USB (J10)
D- P15_7
10-pin SWD SWDIO P10 PSoC 5LP

programming | SWDCLK  |pq 4
and debugging —SWe——p13
header o P14
(J?) XRES XRES

P12 P0OO PO_1 P34 P35 P36 P3_7 P12.6 P12.7 P30

J8 2
J8 3
J8_4

PSoC 5LPp 22
I/O Header jzfj
(J8) p

Js_8
J8_9

J8_10
Jg_12

6.3.1 Building a Bootloadable Project for PSoC 5LP

All bootloadable applications developed for the PSoC 5LP should be based on the bootloader hex
file, which is programmed onto the kit. The bootloader hex file is available in the kit files or can be
downloaded from the kit webpage.

The hex files are included in the following kit installer directory:
<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\
<version>\Firmware\Programmer\KitProg_ Bootloader

Figure 6-36. KitProg Bootloader Hex File Location

@ Qv| « 1.0 » Firmware » Programmer » KitProg_Bootloader - | +4 | | Search
Organize ~ Include in library = Share with - Burn Mew folder
Favorites MName Date modified Type
M Desktop KitProg_Bootloader.elf 3/18/2013 6:38 PM  ELF File
4 Downloads | | «=itProg_Bootloaderhex__—> 3/18/2013 6:38 PM  HEX File
« Dropbox I
-+ Rerant Dlareac
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To build a bootloadable application for the PSoC 5LP, follow this procedure:
1. In PSoC Creator, choose File > New > Project and select Target Device; select <Launch
Device Selector...> from the drop-down list, as shown in Figure 6-37.

Figure 6-37. Opening New Project in PSoC Creator

, |

Select project type
Chonse the type of project - design, library, or workspace.

Design project:
() Target kit:
(7 Target module:
@ Target device: |PSoC5LP || Last used: CYSC5388AXG-LPO36 -
= e ) Last used: CYBCHBEBAXA-LPOG6
0 Library project CYSCE2LP
CYBCH4LP
& Wiorkspace CYBCEELP

LP
<launch Uevice Selector...> | |

2. Select CY8C5868LTI-LP039, as shown in Figure 6-38. Click OK; then, click Next.

Note: In PSoC Creator 3.1 or earlier, you must either set the Application Type as Bootloadable
in the New Project window under the Advanced section, or you can change it after project
creation by selecting Project > Build Settings and clicking <Project Name> > Application
Type > Bootloadable. Beginning with PSoC Creator 3.2, the Application Type option is
removed from the New Project window and the Build Settings menu. PSoC Creator 3.2 and later
versions automatically recognize the application type from the TopDesign schematic.
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Figure 6-38. Selecting Device in PSoC Creator

Device Selector

|#] View Datasheet [EE] Hide/Show Columns.. *> Reset to Defaults

CYBC5868AXI-LPO35

CortexM3

PSoC5LP

CYBC58LP

100-TQFP

CY8C586ELTI-LPO36

CortexM3

PSoC5LP

CYBC58LP

68-QFN

CY8C586BLTI-LPO3E

BLTI-LPO39

CYBC5888AXI-LPO9G

CortexM3

CortexM3

CortexM3

PSoC5LP

PSoC5LP

PSoC5LP

CYBC58LP

CYBC58LP

68-QFN

68-QFN

100-TQFP

67.01

<

I

67 of 67 devices found

Clear Filters

Advanced Topics

3. Choose Empty schematic in the Select project template dialog, as shown in Figure 6-39. Click

Next.

Figure 6-39. Choose Empty Schematic

.
i ijem&u

Select project template
Choose a schematic template or start your design with a kit or example project.

no1n

Code example
Choose from our library of code examples.

Empty schematic
Create a full custom design by adding functionality from the component catalog.

4. In the Create Project dialog, choose the workspace name, location, and project name

(Figure 6-40). Click Finish.
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Figure 6-40. Create Project Dialog

.
Create Project - CY8C5868LTI-LP039 [

Create Project

Choose a name and location for your design.

Workspace: Create new workspace -

Workspace name: Bootloadable Project

Location: C:M\Userssaga'\Documents'saga E

Project name: Bootloadable

5. Navigate to the Schematic view and drag and drop a bootloadable component on the top design.

Figure 6-41. Bootloadable Component in Component Catalog
Component Catalog (202 components) > X
| | e | e
@ﬁ Search for...

Cypress ]/OFF-Chip ] B
Cypress Component Catalog
@ Analog
(-8 CapSense
[-6& Communications
-4 Digital
%8 Display
[
[
[

H-fed Filters

6@ Ports and Pins

t-d Power Supervision

68 System

-.[¢| Boost Converter [v5.0]
Sl Bootloadable [v1.60]

-[¢| Bootloader [v1.60]

~[#] Clock [v2.20]

(] Die Temperature [v2.0]
~[#] DMA [v1.70]

--[¢] EEPROM [v3.0]

~[#] Emulated EEPROM [v2.0]
G- External Memcry Interface
@ Global Signal Reference [v2.10]
|8 ILO Trim [v2.0]

~[#] Interrupt [v1.70]

-[¢] RTC [v2.0]

@ SleepTimer [v3.20]

&g Thermal Management
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Set the dependency of the Bootloadable component by selecting the Dependencies tab in the
configuration window and clicking the Browse button. Select the KitProg_Bootloader.hex and
KitProg_Bootloader.elf files; click Open.

Figure 6-42. Configuration Window of Bootloadable Component

-

Configure 'Boctloadable’ @l&]
Mame: Bootloadable_1
General /* Dependencies | Built-in 4 b

Bootloadable projects require a reference to the associated Bootloader project’s HEX and ELF
files. The HEX files extension is ~hex. The ELF files extension depends on IDE and can be
“elf, “.out, “.=d, orother.

Bootloader HEX file:

Browse...
Bootloader ELF file:

Browse...

Figure 6-43. Selecting KitProg Bootloader Hex File
[ Select a Bootloader Hex File w

@Ov|. « Firmware » Programmer » KitProg_Bootloader v|¢1~|| Search KitProg_Bootloa ,Ol

Organize ~ New folder = - [ 9

M Desktop “  Name Date modified  Type
4 Downloads =
KitProg_Bootloader.hex 3/18/2013 6:38.. HEXFile
+# Dropbox

< Recent Places

| Libraries

m

*. Documents
4 Music

=L Pictures

;i, Videos

‘A Computer
& Windows7_05 (C:
@ Lenovo_Recovery = « |

-

File name: KitProg_Bootloader.hex - lHe)( Files (*.hex) V]

[ Open |vH Cancel ]
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Figure 6-44. Selecting KitProg Bootloader File
[ Select a Bootloader Hex File ﬁw

@U'| , « Firmware » Programmer » KitProg_Bootloader - |#¢| Search KitProg_Bootloader ,Ol
Organize » Mew folder =~ i .@.
i MName Date modified Type

[ Favorites N
B Desktop || KitProg_Bootloader.elf 4/18/20131:07 AM  ELF File
& Downloads

m

2| Recent Places

|| = Libraries
3 Documents

] @' Music
| Pictures
|| BE videos

1M Computer
i &, Local Disk (C)
| CYBCSE Family Processo = 4 T ] b

Famms ~ | Ef Files (*.clf, ., .out) -|

g ] [ oma |

3. In the General tab, check the Manual application image placement checkbox and set the
Placement address as “0x00002800” as shown in Figure 6-45.

Figure 6-45. Bootloadable Component-General Tab

Configure 'Bootloadable_vl_60" T | E
Mame Bootloadable_1
" General | Dependencies | Built-in 4
Application version: (0000
Application 1D 0000
Application custom 1D: (00000000

Manual application image placement
Placement address: 00002800

Checksum exclude section size (bytes): |0

CE = o=

4. Develop your custom project.

5. The NVL setting of the Bootloadable project and the KitProg_Bootloader project must be the
same. The KitProg_Bootloader.cydwr system settings is shown in the following figure.
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Figure 6-46. KitProg Bootloader System Settings

Advanced Topics

Option Value
£ Configuration
Device Configuration Mode: Compressed
- Enable Errer Correcting Code (ECC) ]
Store Configuration Dats in ECC Memory [&]
~ Instruction Cache Enabled 5|
Ensble Fast IMO During Startup E]
Unused Bonded 10 Allow with info
- Heap Size (bytes) 0x1000
Stack Size (bytes) 0x4000
- Include CMSIS Core Peripheral Library Files [E]

£} Programming'Debugging

Debug Select GPIO

Enable Device Protection ]
+ Embedded Trace (ETM) [
Use Optional XRES I}
= Operating Conditions
VDDA (V) 5.0
-~ Variable VDDA ]
VDDD (V) 5.0
VDDIOO (V) 5.0
- VDDIOL (V) 5.0
VDDIOZ (V) 5.0
-+ VDDIO3 (V) 5.0

Temperature Range

-40C - 85/125C

Sets the Port 1 prefemd program/debug interface [/TAG or SWD or SWD+SWV) that the chip enables by defauit for use after power up or reset. Setting to GPIO frees the pins for use as GPIOs but does not completely disable the debug nterface for flash protection puroses. "Enable Device Protecti
32 st forthis purmose. Far more information abot pragramming and debugging options s=e the device data sheet or Technical Refarence Manual (TRM)

6. Build the project in PSoC Creator by selecting Build > Build Project or [Shift]+[F6].

7. To download the project on to the PSoC 5LP device, open the Bootloader Host Tool, which is
available from PSoC Creator. Select Tools > Bootloader Host.

Figure 6-47. Opening Bootloader Host Tool from PSoC Creator

File Edit View Project Build Debug
FNdSHdEGR 4 a@ X9
- 2% 2 08 G & DR R VLN
Workspace Explorer

Tools | Window Help

Install drivers for pVision
Datapath Config Tool...
DMA Wizard...

100% -®&
s Serif ~ 10

'opDesign.cysch

3

L] Bootloader Host...

.@ Workspace 'Bootloadable project’ (1 Projects)
=Pz Project *Bootloadable’ [CY8C5868LTH PQ

~{&]' TopDesign.cysch
P Bootloadable cydwr
EHD Header Files

- i[n] device h

EHE Source Files

Options...
Q
E [l
oD
o -
EXN
anl

8. Keep the reset switch (SW1) pressed and plug in the USB Mini-B connector. If the switch is
pressed for more than 100 ms, the PSoC 5LP enters into bootloader. The PSoC 5LP also enters
into bootloader when the power supply jumper for the PSoC 4 (J13) is removed and
subsequently the USB Mini-B connector is plugged into header J10.
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9.
0x04B4, PID as 0xF13B, and click OK.

Figure 6-48. Port Filters Tab in Bootloader Host Tool

& Bootloader Host | = | @ Bg

|1

File  Actions Help

@ SO0

File: loadable Project'Boctloadable cydsn\CortexM3WARM_GCC_541'Debug'Boctloadable cyacd [:]

Ports: Active application:
[ secuity key

O« (0OD||00[|0OO|(0O(| OO| (0D

- ~
Port Filters [

[] Show BLE Dongles
[ Show 12C Ports

[] Show 5P1 Ports

[] Show UART Ports
Show USE Devices

VID: Bx  04B4
PID: @« F13B
I 0K I Cancel
Log: m—
03:17:00 PM - Selected device: USB Human Interface Device (04B4_F13B) - USB
VID: 04B4
PID: F138

Advanced Topics

In the Bootloader Host tool, click Filters and add a filter to identify the USB device. Set VID as

10.1n the Bootloader Host tool, click the Open File button to browse to the location of the bootload-

able file (*.cyacd).

Figure 6-49. Opening Bootloadable File from Bootloader Host Tool

4] Bootloader Host Elﬂlg
Fi

le  Actions Help

@5

File: | loadable Project'Boctloadable cydsn'ContexM3\ARM_GCC_541'Debug"Boctloadable cyacd [:]

Ports Active application:

Securiyk
Interface Device (04B4_F13B) - USB L Semrley

O« |0OD|| 00| |0D|| 00| (0D |00

Program Button

Open File Button

Log:

03:34:48 PM - Selected device: USE Human Interface Device (04B4_F13E) - USB
VID: 04B4

PID: F13B
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11.Press the Program button in the Bootloader Host tool to program the device.

Figure 6-50. Selecting Bootloadable.cyacd File from Bootloader Host

& Open =5
@Qv| « CortexM3 » ARM GCC 441 » Debug » ~[ 43 |[ search Debug P
Crganize ~ New folder B 1 2]

-
- Favorites i Name Date modified Type
B Desktop | deps 4/18/2013 12:34 PM  File folder
/s Downloads Bootloadable.cyacd 4/18/2013 12:34 PM  CYACD File
+# Dropbox

<» Recent Places

.| Libraries

‘. Documents

4. Music
=L Pictures
i Videos
‘& Computer
B Windows? 0S (C: 7 ¢ i o
File name: Bootloadable.cyacd - lBOOtloaderFiles v]
[ Open |'l I Cancel l

12.1f bootload is successful, the log of the tool displays "Successful"; otherwise, it displays "Failed"
and a statement for the failure.
Notes:

1. The PSoC 5LP pins are brought to the PSoC 5LP GPIO header (J8). These pins are selected to
support high-performance analog and digital projects. See A.2 Pin Assignment Table on
page 120 for pin information.

2. Take care when allocating the PSoC 5LP pins for custom applications. For example, P2[0]-P2[4]
are dedicated for programming the PSoC 4. Refer to A.1 CY8CKIT-042 Schematics on page 116
before allocating the pins.

3. When a normal project is programmed onto the PSoC 5LP, the initial capability of the PSoC 5LP
to act as a programmer, USB-UART bridge, or USB-12C bridge in not available.

4. The status LED does not function unless used by the custom project.

For additional information on bootloaders, refer to Cypress application note, AN73503 - PSoC® USB
HID Bootloader.
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Building a Normal Project for PSoC 5LP

Advanced Topics

A normal project is a completely new project created for the PSoC 5LP device on the CY8CKIT-042.
Here the entire flash of the PSoC 5LP is programmed, overwriting all bootloader and programming
code. To recover the programmer, reprogram the PSoC 5LP device with the factory-set KitProg.hex

file, which is shipped with the kit installer.

The KitProg.hex file is available at the following location:

<Install_Directory>\CY8CKIT-042 PSoC 4 Pioneer Kit\<version>\Firm-

ware\Programmer\KitProg

This advanced functionality requires a MiniProg3 programmer, which is not included with this kit. The

MiniProg3 can be purchased from www.cypress.com/CY8CKIT-002.

To build a normal project for the PSoC 5LP, follow these steps:

1. In PSoC Creator, choose File > New > Project and select Target device; select <Launch

Device Selector...> from the drop-down list as shown in Figure 6-51.
Figure 6-51. Opening New Project in PSoC Creator

, |

Select project type
Choose the type of project - design, library, or workspace.

Design project:
() Target kit:
(") Target module:
@ Target device: |PSoC5LF || Last used: CYBC5838AXQ-LP036 -
= e ) Last used: CYBCEB88AXQ-LPOSE6
© Ubrary project CYEC52LP
CYBCH4LP
[E o =nacs CYECBELP

EE;E&E‘LP
<Launch Uewvice Selector..= | |

2. Select CY8C5868LTI-LP039, as shown in Figure 6-52. Click OK and click Next.
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Figure 6-52. Select Device

|#] View Datasheet [EE] Hide/Show Columns... > Reset to Defaults

TUU=TUTF

Advanced Topics

CYBC3868AX-LP0O35

CortexM3

PSoC5LP

CYBC58LP

100-TQFP

CYB8C5868LTI-LPO36

CortexM3

PSoC5LP
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68-QFN

CYBC5868LTI-LPO3E

-LPO39
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CortexM3

PSoC 5LP

PSoC5LP

CYBCS8LP

CY&C58LP

68-QFN

100-TQFP

67.01

<

LU}

67 of 67 devices found

Clear Filters

3. Choose Empty schematic in the Select project template dialog, as shown in Figure 6-53. Click

Next.

Figure 6-53. Choose Empty Schematic

Create Pmﬁiﬂaﬁ_@

Select project template
Choose a schematic template or start your design with a kit or example project.

Code example

Choose from our library of code examples.

Empty schematic
Create a full custom design by adding functionality from the component catalog.

CY8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J

98



A

ws CYPRESS

~mg> EMBEDDED IN TOMORROW Advanced Topics

4.

In the Create Project dialog, choose the workspace name, location, and project name

(Figure 6-54). Click Finish.

Figure 6-54. Create Project Dialog

Create Project - CYSC5868LTI-LP039 [P [
Create Project
Choose a name and location for your design.
Create new workspace

Workspace name: Bootloadable Project

Location: C\Users‘saga Documents'saga

Project name: Bootloadable

< Back |[ Feich ] | Encel |

9.

Develop your custom project.

Build the project in PSoC Creator by selecting Build > Build Project or [Shift]+[F6].

Connect the 10-pin connector of MiniProg3 to the onboard 10-pin SWD debug and programming
header J7 (which needs to be populated).

To program the PSoC 5LP with PSoC Creator, click Debug > Program or [Ctrl]+[F5]. The Pro-
gramming window shows MiniProg3 and the selected device in the project under it
(CY8C5868LTI-LP039).

Click on the device and click Connect to program.

Notes:

1.

The 10-pin SWD debug and programming header (J7) is not populated. See the 'No Load Com-

ponents' section of A.6 Bill of Materials (BOM) for details.

The PSoC 5LP pins are brought to the PSoC 5LP GPIO header (J8). These pins are selected to

support high-performance analog and digital projects. See A.2 Pin Assignment Table for pin infor-
mation.

Take care when allocating the PSoC 5LP pins for custom applications. For example, P2[0]-P2[4]
are dedicated for programming the PSoC 4. Refer to A.1 CY8CKIT-042 Schematics before allo-

cating the pins.

When a normal project is programmed onto the PSoC 5LP, the initial capability of the PSoC 5LP
to act as a programmer, USB-UART bridge, or USB-I2C bridge in not available.

The status LED does not function unless used by the custom project.
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6.4 PSoC 5LP Factory Program Restore Instructions

The CY8CKIT-042 PSoC 4 Pioneer Kit features a PSoC 5LP device that comes factory-programmed
as the onboard programmer and debugger for the PSoC 4 device.

In addition to creating applications for the PSoC 4 device, you can also create custom applications
for the PSoC 5LP device on this kit. For details, see section 6.3 Developing Applications for PSoC
5LP on page 88. Reprogramming or bootloading the PSoC 5LP device with a new flash image will
overwrite the factory program and forfeit the ability to use the PSoC 5LP device as a programmer/
debugger for the PSoC 4 device. Follow the instructions to restore the factory program on the PSoC
5LP and enable the programmer/debugger functionality.

6.4.1 PSoC 5LP is Programmed with a Bootloadable Application

If the PSoC 5LP is programmed with a bootloadable application, restore the factory program by
using one of the following two methods.

6.4.1.1 Restore PSoC 5LP Factory Program Using PSoC Programmer

1. Launch PSoC Programmer 3.27.1 or later from Start > Cypress > PSoC Programmer.

2. Configure the Pioneer Kit in Service Mode. To do this, while holding down the reset button (SW1
Reset), plug in the PSoC 4 Pioneer Kit to the computer using the included USB cable (USB A to
mini-B). This puts the PSoC 5LP into service mode, which is indicated by the blinking green sta-
tus LED.
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3. The following message appears in the PSoC Programmer results window: “KitProg Bootloader

device is detecte
Figure 6-55. PSoC

% DPSoC Programmer

File  View Options Hel

- s C

d”.
Programmer Results Window

(@] (=] E ]

p

Port Selection N‘

Programmer | Utilities | JTAG |

Programming Parameters

File Path: C:\Program Files (x86)\Cypress\CYBCKIT-042 PSoC 4 Pioneer Kit\1.0\Firmware\Programmer\KitPr
| 1 ] ¢
Programmer:
Programming Mode: @ Reset Power Cycle Fower Detect
Verification: ) Off Connector: 5p @ 10p
AutoDetection:
Device Family AutoDetection: Off Clock Speed: |1.6 MHz
CY8CHouLP - Programmer Characteristics Status ) )
Protocol: JTAG @ SWD 1s5P 12c Execution Time:
Device Voliage: ) 50v © 33v ) 25v O gy | CowerSeus —
CYBC586BLTI-LPO39 - Voltage: NA
Actions Results Il

Connected at 6:40:11

Device set to
CYSB8CS868LTI-LFO39 at
6:38:29 PM

Device Family set to
CYBCoxxxLF at &6:38:2
BActive HEX file set
6:38:28 PM

PM EitProg bootloader device is detected
Pleaze close all ports, then navigate to the Utilities tab and click the
Upgrade Firmware button to recover Bridge
Select Port in the PortList, then try to connect

262144 FLASH bytes

m

3 PM
at C:\Program Files (x86)\Cypress\CYBCKIT-042 P5oC 4 Pioneer
Kit\1l.0\Firmware\Programmer\KitProg\KitProg.hex

Users must be aware that the following PSoC device should not be powered or
programmed at 5V. Doing so will cause damage to the device:

CYBCE9xNX

For Help, press F1 |

4. Switch to the Utilities tab in PSoC Programmer and press the Upgrade Firmware button.
Unplug all other PSoC programmers (such as MiniProg3 and DVKProg) from the PC before
pressing the Upgrade Firmware button.

Figure 6-56. Upgrade Firmware

N = e

% DPSoC Programmer

File  View Options

- s C

Help

N‘ | Programmer I Utilities | JTAG |

Fort Selection
Click to upgrade connected device's fimware
Erase Block Click to erase user specific flash block

Device Family

CYBCHoml P -

Device

CYBCH86BLTI-LPO35 -

Actions Results Il

Connected at 6:40:11 PM EKitProg bootloader device iz detected
Pleasze close all ports, then navigate to the Utilities tab and click the

Upgrade Firmware button to recover Bridge
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5. After programming has completed, the following message appears: “Firmware Update Finished
at <time>".

Figure 6-57. Firmware Update Complete
"@- PSoC Programmer l =Ane ]

File View Opticns Help
4 B
@ 3secePB0D
Port Selection 4p Programmer| Utilities | JTAG ‘
[ KitProg/1DOE 122000232400
Click to upgrade connected device's fimwars

Click to erase user specific flash block

Device Famity
CY8CEIoc

Device
CYBC6347B7Z1-BLD53

Actions ‘Resulcs

I RitProg Version 2.19 I—K'nProg Firmware Version

1 Firmware Update Finished at 3:53:31 PM
Succeeded
Verifying... [——————Firmware update message
i Upgrading...
Initializing...
IT Srarred ar S.53.00 DM

I Firmware Upgrade Requested at 3:53:00 PM

Please navigate to the Utilities tab and click the Upgrade Firmware button

Port Cpened with Warnings at 3:52:49 PM KitProg version Expecting 2.18, but found 2.17.
Cpening Port at 3:52:47 PM
Connected at 3:52:46 PM KitProg/1D0OE192D00232400
Disconnected at 3:52:42 PM Bootloader device
| Connected at 3:52:34 PM KitProg bootloader device is detected

For e, press 1 W PSS Powsred  Comedted

6. The factory program is now successfully restored on the PSoC 5LP. It can be used as the pro-
grammer/debugger for the PSoC 4 device.
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Restore PSoC 5LP Factory Program Using Bootloader Host Tool

1. Launch the Bootloader Host tool from Start > Cypress > PSoC Creator.

2. Using the File > Open menu, load the Kit Prog.cyacd file, which is installed with the kit software.
The default location for this file is: <Instal l_Directory>\CY8CKIT-042 PSoC 4 Pioneer
Kit\<version>\Firmware\Programmer\KitProg\KitProg.cyacd

Figure 6-58. Load KitProg.cyacd File

% Bootloader Host

[ ——— . o

File  Actions

e

Help

Ports:

File:  \Cypress\CYBCKIT-042 PSoC 4 Pioneer Kit\1.0WFirmware" Programmer'Kit Prog"Kit PFrog..cyacd

Active application:

Communications Port (COM1) - UART

[T Security key

O« |0O0((0O0|(0O0||0D0)| 00| | 0D

Log:
Ready
' ™
2 open (o) (s
W = - -
OUO . =« Firmware » Programmer » KitProg v|¢,|| Search KitProg pl
—— =
Organize » Mew folder =« 0 @
S Favorites i MName : Date modified Type Size
Bl Desktop || KitProg.cyacd 4/18/2013 1:07 AM  CYACD File 121 KB|
& Downloads L "
= Recent Places i
E Google Drive
I *# Dropbox —
. No-Zoolz Zone
& SkyDrive
4 Libraries
@ Apps
[ Noruments s 1
File name: KitProg.cyacd - [Bootloader Files V]
[ Open |v] Cancel ]
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3. Configure the Pioneer Kit in Service Mode. To do this, while holding down the reset button (SW1
Reset), plug in the PSoC 4 Pioneer Kit to the computer using the included USB cable (USB A to
mini-B). This puts the PSoC 5LP into service mode, which is indicated by the blinking green sta-

tus LED.

4. In the Bootloader Host tool, set the filters for the USB devices with VID: 04B4 and PID: F13B.
USB Human Interface Device port appears in the Ports list. Click that port to select it.

Figure 6-59. Select USB Human Interface Device

/%] Bootloader Host

SN o

File  Actions Help

A YEERY)

Log:

File:  C:\Program Files"\Cypress"CYBCKIT-042 PSoC 4 Pioneer Kit\1.0\Fimware \Programmer'Kit ProgKit Prog.cyacd B

Ports: Active application:
Security ke

USB Hurnan Interface Device (04B4_F138) - USB B {:c”"tf = =

05:00:25 PM - Selected device: USE Human Interface Device (04B4_F13B) - USE
VID: D4B4
PID: F13B

Ready

h

5. Click the Program button (or menu item Actions > Program) to restore the factory-program by

bootloading it onto the PSoC 5LP.

6. After programming has completed, the following message appears: “Programming Finished Suc-

cessfully”.
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Figure 6-60. Programming Finished Successfully

Advanced Topics

L Bootloader Host =5 i&‘

File  Actions Help

(= & BB /Q

File:  \Cypress\CYBCKIT-042 PSoC 4 Pioneer Kit'.1.0Firmware'\Programmer.Kit Prog*KitProg cyscd E

Ports Active application:

Communications Port (COM1) - UART a ‘:C”';T:k?’: =5 (301 (35

KitProg USB-UART (COME0) - UART

KitProg/1E1606CB00086400 - [2€ Baud:
Stop Bits:
o

Log:

VID: 04B4
PID: F138

05:06:10 PM - program Started
05:06:16 PM - program Finished Successfully
05:06:16 PM - program completed in 6082 ms.

05:06:18 PM - Selected device: Communications Port (COM1) - UART
Generic Serial Port

3

mn

Ready

7. The factory program is now successfully restored on the PSoC 5LP. It can be used as the pro-

grammer/debugger for the PSoC 4 device.

PSoC 5LP is Programmed with a Standard Application

If PSoC 5LP is programmed with a standard application, restore the factory program by using the fol-
lowing method.

1.
2.

Launch PSoC Programmer 3.27.1 or later from Start > Cypress > PSoC Programmer.

Use the File > Open menu to load the KitProg.hex factory program hex file, which is shipped with
the kit. The default location for this file is: <Install_Directory>\CY8CKIT-042 PSoC 4

Pioneer Kit\<version>\Firmware\Programmer\KitProg

. Connect a CY8CKIT-002 MiniProg3 (sold separately) to the computer. The 10-pin connector

cable on the MiniProg3 plugs into the header [J7]. Note that the J7 header is unpopulated. For
more details, see A.6 Bill of Materials (BOM) on page 125.
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4. Ensure that MiniProg3 is the selected port in PSoC Programmer and the 10-pin connector (10p
option) is selected, as shown in the following figure. If the board is not powered over USB, select
the Power Cycle programming mode.

Figure 6-61. Select MiniProg3
V% PSoC Programmer E‘E‘g

File View Options Help

- OB DB
Port Selection Ap | Pregrammer | usiities | JTaG |

B MiniProg2/1430DD0000EY Programming Parameters Memory Types
File Path PSoC 4 Pioneer Kiti1. 0\Firmware\Programmer'KitProg\KitProg.hex [ Load from hex ] [ Load from device
€ [ [ ] v
Main Flash [64K]
Programmer. MiniProg3/1430DD0000ES
Programming Mede: () Reset @ Power Cycle Power Detect
Verification: @on O off Connector ) 5p @ 10p
Device Famiy AutoDetection: @on O of Clock Speed. [1.6MHz =
CY8CEDec Programmer Characteristics Status N
Protocol: ©) JTAG @ SWD O Issp o ExecufionTime: 0.Tseconds Size (bytes):
Device Voltsee: ® 50V ) 33V 0 25y O 1gy  CowerSlabs OFF Start address
CYBCE347BZ/-BLD53 o ) ) - Voltage: 180 mv End address:
Actions Results i

Memory Types Load from HEX Finished at 5:...

Memory Types Load from HEX Requested at 5...

Aertive HEX file set at 5:18:13 PM C:\Program Files\Cypress\CYECKIT-042 P50C 4 Pioneer Kit\l.0\Firmware\Programmer...
Successfully Connected to MiniProg3/1430D... MiniProg3 wersion 2.05 [3.10/2.09]

Cpening Port at 5:16:45 PM

Connected at 5:16:45 PM MiniProg3/1430DD0000OES

m

Select Port in the Portlist, then try to connect
Memory Types Load from HEX Finished at 5:...
Device set to CYBC6347BZI-BLDS3 at 5:14:5... 1048576 FLASH bytes
Device Family set to CYBC63xx at 5:14:55 PM
Memory Types Load from HEX Requested at 5...

Active HEX file set at 5:14:53 PM E:\Mini[—‘Ing3\JTBG_Chain_Prngra.m.m.ing_[—lax\Blinky_ol_CYSCESGEAXB*OlQ.hax

Me=ars mist he aware thar the fallowine PSAC dewics shanld nat he mowared ar nrn
< m |

2

5. When ready, press the Program button (or File > Program) to program the PSoC 5LP device.
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6.5

6. After programming has completed, the following message appears: “Program Finished at
<time>".

Figure 6-62. Program Finished

-
% PSoC Programmer

File View Options Help

@SB B0 B

| Por Selection 4Ip | Programmer | usilties | JTAG |
B MiniProg2/3@09AAD00002 Programming Parameters
File Path: C\Program Files (x86)\Cypress\CYBCKIT-042 PSoC 4 Pioneer Kitl1.0'Firmware\ProgrammerKitProg\KitProg.hex

Program Button Programmer: MiniProg3/3209AA000002

Programming Mode: () Reset @ Power Cycle Power Detect

Verification: @ On O Off Connector: ) 5p @ 10p
Device Famly utoUletection @ On () Off Clock Speed: |16 MHz
Programmer Characteristics Status

CY8CHooc P 105 5
Brotocol: ) JTAG @ SWD O 1SSP 12¢ Execution Time: .5 seconds

Device Voltage: @ 50v © 33V O 25v © 1gy | owerSals OFF
CYBCB6ELTILP029 Voltzge: 60 my
Actions Results

Program shed a 00:04 P
Programming Succeeded
Doing Checksum
Doing Protect
Programming of Flash Succeeded...
Programming of Flash Starting...
Erase Succeeded
I Device set to CYEC586ELTI-LPO32 at 6:59:55
M
Device Family set to CYSC5xxxLP at 6:59:55
M

262144 FLASH bytes

Automatically Detected Device: CYBCS586ELTI-LPO39
Program Requested at 6:59:44 PM
Successfully Connected to
MiniProg3/3209AA000002 at 6:58:42 PM
Cpening Port at 6:58:41 PM

MiniProg3 wversion 2.05 [3.10/2.09]

7. The factory program is now successfully restored on the PSoC 5LP. It can be used as the pro-
grammer/debugger for the PSoC 4 device.

Using pC/Probe Tool

Micrium’s pc/probe is a windows application that allows you to read and write the memory of any
embedded target processor during run-time, and map those values to a set of virtual controls and
indicators placed on a graphical dashboard.

This tool helps in designing a simple GUI for the code examples of the development kits with least
effort.

Please note that Micrium uC/Probe tool is not pre-requisite software required to run this kit and does
not get installed along with kit contents.

The license required to use all the features of the tool need to be purchased separately by the user.
However, the educational edition of the tool is available as a free download from
https://www.micrium.com/download/ucprobe-win-installer/.

The Educational Edition of uC/Probe is available for free to enable you to “try before you buy”. For
more details on licensing and the uC/Probe tool, refer to the uC/Probe User Guide and pC/Probe
Target Manual. To learn more about the uC/Probe, visit: micrium.com/tools/ucprobe/overview/.

In Micrium pC/Probe, the Cypress KitProg is being supported as a means of communication to the
target device connected to PC.
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When a code example is built in PSoC Creator, it produces the output files in HEX, LST, MAP, RPT,
and ELF formats.

The ELF file lists all the symbols (variables), symbol types and its addresses. The Micrium uC/Probe
tool reads the ELF file and detects these symbols (global variables) used in the code.

The uC/Probe tool provides a host of graphical controls such as sliders, RGB palette, graphs, and
donuts. The controls required can be dragged and dropped onto uC/Probe workbench and symbols
from ELF file can be assigned to the controls.

When the workbench is run, the changes in symbol value associated with the controls (slider, graph,
and so on) can be visualized on the PC.

Appropriate global variables have been assigned in CapSense and PWM code examples of the kit to
visualize the CapSense output and PWM output on a GUI.

Note: The ELF file is generated by PSoC Creator and is removed during the project clean process.
To use any of the WSPX files, ensure that you build the project so that the ELF file is generated. Oth-
erwise, the yC/Probe tool pops up a message the ELF file is missing.

CapSense Code Example

To visualize the output of CapSense project using uC/Probe tool, follow the steps given below:
1. Program the CapSense code example on CY8CKIT-042 by following steps 1-8 in chapter 5.

2. Download and install uC/Probe tool from https://www.micrium.com/download/ucprobe-win-
installer/.

3. Launch pC/Probe from Start > All Programs > Micrium > uC-Probe > Micruim uC-Probe.
Figure 6-63. Micrium puC/Probe
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B AR J - . ;n-.--lm-ulmlm
e ] - T E - = - . L
<
# -
-
=
[ -
o
e d
[
™
.
.- -

1

CYB8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J 108


https://www.micrium.com/download/ucprobe-win-installer/
https://www.micrium.com/download/ucprobe-win-installer/

o CYPRESS

~amp EMBEDDED IN TOMORROW Advanced Topics

4. Drag and drop a Custom Slider control from Writable Controls in Toolbox on to the Datascreen1.
Figure 6-64. Adding Slider Control
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5. Next, add a RGB Palette from Writable Controls in Toolbox on to the Datascreen1.
Figure 6-65. Adding RGB Palette Control
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6. The DataScreen looks as below after adding both the controls.
Figure 6-66. DataScreen with Slider and RGB controls
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7. Now, click the ELF button in the Symbol Browser window.
Figure 6-67. ELF Button in Symbol Browser

X coe || B3 esr || g @ Search by base | () Search iy Dt Type (5 |[£] | BAM Range Wm0 M FEFRFEER

Larre [rapay Nprme i

8. Browse and point to the CapSense.elf file to load the symbols (global variables) from the
CapSense code example. Wait until the elf file is loaded. The elf file is in the collapsed state by
default. It can expanded by clicking the ‘+’ button next to the file name.

9. On expanding the elf file, it can be seen that the Symbol Browser displays all the .C files in the
code example. By expanding each file, the global variables defined in that C file are displayed
with its name, type, size, memory address, and so on.

10.Now, expand the main.c file to view the global variables defined in main.c file.

Figure 6-68. Global variables in Symbol Browser
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11.Drag and drop the global variable ucSlider on to the custom slider control to see the slider output.
Similarly, drag and drop the global variable ycARGB on to the RGB Palette to see the RGB
output.

Figure 6-69. Assigning slider output to Custom Slider control
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Figure 6-70. Assigning RGB output to RGB Palette control
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12.Connect the CY8CKIT-042 to the computer. Click the Settings button in the uC/Probe tool.
Figure 6-71. Settings Button in uC/Probe
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13.In the uC/Probe setting window, select the Cypress PSoC Prog and select ‘KitProg/<Kit Prog
number>’ from the drop down box for Port and click OK to start communication between the

CYB8CKIT-042 and the uC/Probe tool.
Figure 6-72. uC/Probe Settings
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@ Little Endian ' symbaols /sec
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Interfaces
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14.Click the Run button to start.
Figure 6-73. Run Button
G900
File Home
ML o = & L
O B g
Full Settingg Run Past
Screen RS x ’Ql

Application Clipboard

Toolbox n

15.Now, move your finger on the CapSense slider on the kit and observe the Custom Slider and
RGB Palette control output on the datascreen.

Figure 6-74. Custom Slider and RGB Palette output

#00323200

Note: If you are using Education edition of uC/Probe tool, pop-up windows will be displayed
before starting datascreen. Click OK to continue. Also, the Datascreen (output) will time-out after
1 minute in case of Education edition.

16.Click the File tab and select Save to save the uC/Probe project. Provide an appropriate name
and select a location to save your project. The uyC/Probe projects are saved with extension
.WSPX. Double-clicking a .WSPX file opens the uC/Probe tool.

PWM Code Example

The uC/Probe project for PWM project is already created and packaged along with kit content. The
MC/Probe projects can be found in the installation folder at <Install_Directory>\CY8CKIT-
042 PSoC 4 Pioneer Kit\<version>\uCProbe.
1. Program the PWM code example on CY8CKIT-042 by following steps 1-8 in 5.4 PWM on

page 49.
2. Double-click the CYBCKIT-042_PWM.wspx file.
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3. Browse and point to the PWM.elf file to load the symbols (global variables) from the PWM code
example.

4. Connect the CY8CKIT-042 to PC and follow steps 12 to 14 described above to start running the
datascreen.

5. The PWM compare values are displayed graphically and the RGB palette displays the RGB LED
output on the datascreen.

Figure 6-75. PWM Compare Values and RGB Output
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A1 CYS8CKIT-042 Schematics

23100 . PLACE CAPS CLOSE TO POWER PINS
u
P4_VDD
oloalo|olola]a — 4 VCCD 0.1uF‘
uz J[295|2 R [8[H[8[8[S o
J12[S=[S O uF
MO ONTOLLA
R =Y P4 VDD
1 caonaaaa¥9Q 33
= VsS > VCCD [
2 0 2 vl 732 IXRES
= P2_0 XRES 3 B
21 3| P2 31 07
= P2_1 PO_7 |3 5
2 2 4 — - | 30 06
= P22 P0_6 |5 5
2 3 5 - 0 [™29 05
P24 6 |"23 P0_5 38 PO 4
P2 5 7 P24 cvscazasAxi4ass aaTaFp P04 57 PO 3
5 P2_5 P0_3 5
2 6 8 26 02
5 P2_6 PO_2 B J13
2 7 9 25 0_1
P2_7 v PO_1 B
19 1 \ss ogd PO 0 |2 00 1
=0 .
P30 11| 5% 29 pa s |2 P4 3 2
- == - Cc9
@, a 10000 pF 2 PIN HDR
:; = N0 ¥ 0,0~ A O = Sh_tank
OMmOOmOOOST TS
ponadoada>00n NO LOAD
O P I VDD R6 ZERO P4_VDD
SYUIS(sY —I—
. VTARG
v—odvmmr\ ol—|a R4 ZERO
gllelrell| [FiEf P4 VDD
=[=
D[]
R10
P4_VDD 47K
PSoC 4 IXRES

CY8CKIT-042 PSoC® 4 Pioneer Kit Guide, Doc. # 001-86371 Rev. *J 116



EMBEDDED IN TOMORROW

&2 CYPRESS

Power Supply

Input Voltage Range VIN is 5-12V
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XRES VCCA | 0.1 uF 1.0 uF
N P10 P15_3 75X =
P 152 39— poLp12 1 c19
P12 SI0, 12C1_SDAP12_1 |55 SaLETS 0 T0uF
NO LOAD  P5LP_TDI P1_3 SIO, 12C1_SCL P120 |57 i
5| P14 7 36 P s
P15 00, = P36 (35
R7 ZERO VvDDIO1 2555 oo VDDIO3
P5LP_VDD Q\N\N‘N‘Lﬂlmlg g 0 100/ T, P5LP_VDD %
bbb e b bl DO —mmmm»n®
aoooooo>>>00000000
S 0 P PSLPO_4 to PSLPO_7,
(TSN N[N N NS e ]) PSLP3_2, PSLP3_3 are
C20 __021 reserved for HW REV ID
= .1 uF oo = .1 uF
) of~a[= °l7 1)
~[a[O10] |9 2Rl 2
N~ D) ] |
© —[%4[%le] N2 i R
- [aR [72) [7e) ()
o #) oo
#’ o
VBUS 2|  VIARG P5LP_VDD
als c22
oja .1 uF
R3! R37 Rak
1.51 1.5 :
P5LP_XRES
R40, R38
3K 3K
PSoC 5LP Programmer / Debugger
NO LOAD
R4 0
Ve EXT a1 - PMOS(DMP3095L7) l vas
L R43 Q2
2 . 442 ohm
o U Q3
g z 2 X
g |, 28 S S PMOS( DMP3098L-7)
"APS = ]
o > 0 O
= o 8 3
8 N A D5
T o
S = 1K ohm
i
>
Protection Circuit
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VTARG
B R32 ZERO
> SWDIO
6 VN
z ] p P5LP: R33 ZERO
g 8 : 2 I SWDCLK
I3 E g C R34 ZERO
FALP
g L : IXRES
50MIL KEVED SMD

A4

PSoC 4 / External PSoC Program/Debug Header

P5LP_VDD
J7
2 P5LP_SWDIO
c27 |, 33 ! 2 P5LP_SWDCLK
N 28 3 4 FELF SWO
“lo.1uF 3 ? g P5LP_TDI
B5LP
9 10 LP_XRES
50MIL KEYED SMD
:; NO LOAD
PSoC 5LP Program/Debug Header

P5LP_VDD

J8
P5LP1 2
[P0 0 oz 5LP0_1
mepaa 13 4 BeLF3 S
PePa s |5 © BeLEs 7
pstpize |/ 8 P5LP12 7
8 10 P5LP3 0

1 12
6x2 RECPT

PSoC 5LP GPIO Extension Header

NO LOAD  NO LOAD NO LOAD

TP3 P4 PS5 TP6
BLACK | BLACK | BLACK | BLACK

NO LOAD
TP2 RED VBUS

.

F1

USB MiniB

PTC Resettable Fuse

DM
DP.
8.5 8
AAR
100K R13
.
11
C16 0.01 uF
77
P4_VDD
J5 J12
P3 5 P3 1

|
|
of

|
|

1 2
2013 4
IXRES 5 6

|
M P30
H IXRES |
g 3x2 RECPT
NO LOAD
g—s J

Z| 6X1 CONN FEMALE
§ NO LOAD

|
ol
ol

J12 Arduino ICSP
compatible header for

L SPI Interface
J5 Digilent PMOD Cards

Compatible Headers

TvS4 12C PUll up
18V 350W B Resistors
g3
VIN NI "
1 9
2 8
3 - 7
4 ol
TXRES g 0 i
p4_vDD}—OREF__ |7 s
8 AP
X1 F 1
81 RECP
10X1 RECP
J2
P! PO 2 P4_VDD J4
1 27poa Po4 [
5 3 4 ok
5 R 22
P24 |7 8 Pia P37 |3
5 910 13 4
= 11 12 0015
P 13 14 P12 B2 16
015 R 777
17 18 8
"~ 9x2 RECP 8x1 RECP

(J1-J4) Arduino Compatible Headers
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Pin Assignment Table

This section provides the pin map of the headers and their usage.

A.21 Arduino Compatible Headers (J1, J2, J3, J4, and J12)
J1
Pin Kit Signal Description
J1_01 VIN Input voltage to the board
J1_02 GND GND
J1_03 GND GND
J1_04 5V 5V voltage
J1_05 3.3V 3.3 V voltage
J1_06 RESET IXRES
J1_07 IOREF I/O voltage reference
J1.08 NC Not connected
Pin PSoC 4 Signal PSoC 4 Description Pin PSoC 4 Signal PSoC 4 Description
J2 01 P2[0] A0 (SARADC input) J2 02 PO[2] Comparator 2+
J2_03 P2[1] A1 (SARADC input) J2_04 PO[3] Comparator 2—
J2_05 P2[2] A2 (SARADC input) J2_06 VDD VDD
J2_07 P2[3] A3 (SARADC input) J2_08 P1[5] Opamp 2+
J2_09 P2[4] A4 (SARADC input) J2_10 P1[4] Opamp 2—
J2_11 P2[5] A5 (SARADC input) J2_12 P1[3] Opamp 2out
J2 13 PO[0] Comparator 1+ J2_ 14 GND GND
J2_15 PO[1] Comparator 1— J2_16 P1[2] Opamp 1out
J2_17 P1[0] Opamp 1+ J2_18 P1[1] Opamp 1-
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J3
Pin PSoC 4 Signal PSoC 4 Description
J3_01 P2[6] D8
J3_02 P3[6] D9(PWM)
J3_03 P3[4] D10(PWM/SS)
J3 04 P3[0] D11(PWM/MOSI)
J3_05 P3[1] D12(MISO)
J3_06 PO[6] D13(SCK)
J3 07 GND GND
J3_08 P1[7] AREF
J3_09 P4[1] SDA
J3_10 P4[0] SCL
J4
Pin PSoC 4 Signal PSoC 4 Description
J4_01 PO[4] DO(RX)
J4_02 PO[5] D1(TX)
J4_03 PO[7] D2
J4_04 P3[7] D3(PWM)
J4_05 PO[0] D4
J4_06 P3[5] D5(PWM)
J4_07 P1[0] D6(PWM)
J4_08 P2[7] D7
J12
Pin Kit Signal PSoC 4 Description
J12_01 P3[1] MISO
J12_02 PSoC 4_VDD VDD
J12_03 PO[6] SCK
J12_04 P3[0] MOSI
J12_05 /IXRES PSoC 4 RESET
J12_06 GND GND
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A.2.2 Digilent Pmod Cards Support Header (J5)
J5
Al Klislanel (D:fsa?xcl:t 1?@?&2‘1‘375)

J5_01 P3[5] SPI_SS (multiplex with J4_06)
J5_02 P3[0] SPI_MOSI

J5_03 P3[1] SPI_MISO

J5_04 PO[6] SPI_SCK

J5_05 GND GND

J5_06 VDD vVCC
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A.2.3 PSoC 5LP GPIO Header (J8)
J8 is a 2x6 header that connects PSoC 5LP pins to support GPIO controls for custom PSoC 5LP projects.
J8
Pin | PSoC 5LP Signal| PSoC 5LP Description Pin Pz‘i’;‘::"’ PSoC 5LP Description
J8_01 PSoC 5LP_VDD |VDD J8 02 P1[2] Digital /0
J8 03 PO[0] Delta Sigma ADC + input |J8 04 PO[1] Delta Sigma ADC — input
J8_05 P3[4] SAR - input J8 06 P3[5] SAR + input
J8 07 P3[6] Buffered VDAC J8 08 P3[7] Buffered VDAC
J8 09 P12[6] UART RX J8_10 P12[7] UART TX
J8 11 GND GND J8 12 P3[0] IDAC output
A3 Program and Debug Headers
A.3.1 PSoC 4 Direct Program/Debug Header (J6)
J6
Pin PS(_)C L P_SoC < Description Pin PS‘.)C s P_SoC . Description
Signal Signal Signal Signal
J6_01 VDD VDD VCC J6_02 P2[0] P3[2] TMS/SWDIO
J6 03 GND GND GND J6_04 P2[1] P3[3] TCLK/SWCLK
J6_05 GND GND GND J6_06 P2[2] NC TDO/SWO
J6_07 NC GND GND J6_ 08 | P2[3] NC TDI
J6_09 GND GND GND J6_10 P2[4] XRES RESET
A.3.2 PSoC 5LP Direct Program/Debug Header (J7)
J7
Pin Pss?:nilfp Description Pin PSS?;::I'P Description
J7_01 VDD VCC J7 02 P1[0] TMS/SWDIO
J7_03 GND GND J7_04 P1[1] TCLK/SWCLK
J7_05 GND GND J7_06 P1[3] TDO/SWO
J7 07 GND GND J7 08 P1[4] TDI
J7_09 GND GND J7_10 XRES RESET
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A4 Use of Zero-ohm Resistors and No Load
Unit Resistor Usage
Power supply R2 Solder zero-ohm resistors to access voltage from VBUS (USB).
. Unsolder the resistors to communicate with an external PSoC
fn% ‘;Oggg‘im" between PSOC 5LP | o4 and R25 | using the PSoC 5LP. Removing these will disable the PSoC 4 12C
communication with the PSoC 5LP device.
PSoC 4/external PSoC program/ R32, R33, and Unsolder the resistors to disconnect SWD lines from the E’SOC 4.
debug header R34 U§e 46 to connect and program an external PSoC. Remgvmg these
will disable PSoC 4 programming by the PSoC 5LP device.
Protection circuit R46 Solder zero-ohm resistors to bypass the entire protection circuitry.
Used when RBleed mode of the CSD is used. To use this feature,
CapSense tuning circuitry R1 you must populate an Rbleed resistor. Refer to the CapSense com-
ponent datasheet.
CapSense shield setting R44, R45 Upsolder R45, wh{ch connects the shield .to ground and solder R44
with zero-ohm resistors to connect Vref via PO_1.
Unsolder R4 to remove supply to VTARG and solder zero-ohm
PSoC 4 R4, R6 resistors R6 to supply P4_VDD with VDD instead of J13.
PSoC 5LP programmer/debugger R11, R12, R14,
R15, R16 For future use.
R5 Unsolder the zero-ohm resistor to cut the VDD supply to PSoC 5LP.
R7 For future use.

A5

Error in Firmware/Status Indication in Status LED

User Indication

Scenario

Action Required by user

LED blinks at a fast rate

(ON Time = 0.25s, OFF Time = 0.25s)

is corrupt

Bootloadable file

Bootload the *.cyacd file over the USB interface,
which is shipped with PSoC Programmer using the
Bootloader Host GUI shipped with PSoC Creator. The
files are located in the PSoC Programmer root instal-
lation directory.

LED blinks at a slow rate

Entered Boot-

a) Unplug power and plug it in again if you entered
this mode by mistake; the LED gives the indication.

loader by press-

successfully

2 (ON Time = 1.5s, OFF Time = 1.55) ing the PSoC 4 b) If the mode entry was intentional, bootload the new
" ’ Reset switch *.cyacd file using the Bootloader Host tool shipped
with PSoC Creator.
Programmer appli- USB is enumerated successfully and the programmer
3 | LED glows steadily cation is running is up and running.The PSoC 4 device can now be pro-

grammed any time using the onboard PSoC 5LP pro-
grammer.

Note: LED status is not applicable when a custom project is running in PSoC 5LP.
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A.6 Bill of Materials (BOM)
No. | Qty Reference Value Description Manufacturer Mfr Part Number
PCB,3.32"x2.1" CAF resistant High Tg
1 ENIG finish, 4 layer, Color = RED, Silk = | Cypress
WHITE.
2 |1 et 2200pFd  |CAP CER 2200PF 50V 5% NPO 0805 |Murata f§M2165C1 H222JA0
C2,C7,C12,C14,C15,C
3 |12 |17,c20,c21,c22,C24, |0.1 uFd CAP .1UF 16V CERAMIC Y5V 0402  |Panasonic - ECG  |ECJ-0EF1C104Z
C25,C27
C3,C5,C8,C10,C11,C1
4 |11 |3,c18,c19,c23,c26,C [1.0uFd %’;/P CERAMIC 1.0UF 25V X5R 0603 |1 vuden TMK107BJ105KA-T
28 °
5 [1 |ca 10UuF 25V |CAP TANT 10UF 25V 10% 1210 AVX Corporation | TPSB106K025R1800
6 |1 |cs 22 UF 16V |CAP TANT 22UF 16V 10% 1210 AVX Corporation | TPSB226K016R0600
7 |1 e 10000 pFd  [CAP CER 10000PF 50V 5% NP0 0805 |Murata ?§M219501 H103JA0
8 |1 |ce 0.01 uFd ga‘; 10000PF 16V CERAMIC 0402 |5, conic- ECG  |ECJ-0EB1C103K
o |g [P1.D2D4D11D12D1 |\ 1000 DIODE SCHOTTKY 0.5A 20V SOD- |Fairchild Semicon- [\ oo
3 123 ductor
10 (1 |p3 Power LED |} £y AMBER 591NM DIFF LENS 2012 | Sharp Microelectron- |, 7y, 100
Amber ics
1 |1 |ps 2V Zener  |DIODE ZENER 2V 500MW SOD123 | Diodes Inc BZT52C2V0-7-F
12 |3 |Ds6, D7, D8 ESD diode |SUPPRESSOR ESD 5VDC 0603 SMD |Bourns Inc. CG0603MLC-05LE
CLV1A-FKB-
13 |1 |Do RGBLED |LED RED/GREEN/BLUE PLCC4 SMD |Cree, Inc. CJIMAF1BBTRAS3
14 |1 |p10 Zf::i LED || ED GREEN CLEAR 0805 SMD Chicago Miniature ~ [CMD17-21VGC/TR8
15 |1 [F1 FUSE PTC Resettable Fuses 15Volts Bourns MF-MSMF050-2
100Amps
6 2 |01 g1 Recp | CONN HEADER FEMALE 8POS 1" |Sullins Connector | 050011 can re
GOLD Solutions
17 |1 52 9x2 RECP CONN HEADER FMAL 18PS.1" DL SuIIln's Connector PPPCO92LFBN-RC
GOLD Solutions
s 1 lus 10x1 RECP | CONN HEADER FMALE 10POS .1 Sullins Connector | 5005101 FBN.RC
GOLD Solutions
50MIL CONN HEADER 10 PIN 50MIL KEYED
19 |1 |Je KEYED SMD | Smb Samtec FTSH-105-01-L-DV-K
o 11 |lis 62 Recp | CONN HEADER FMAL 12PS.1"DL | Sullins Connector | 5050601 man.RC
GOLD Solutions
21 |1 o 3p_jumper | CONNHEADER VERTSGL3POS 14 961103-6404-AR
GOLD
22 1 |40 USB Mini B gﬁgLNEUSB MINIAB SMT RIGHT TE Connectivity 1734035-2
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No. | Qty Reference Value Description Manufacturer Mfr Part Number
23 |1 J13 2p_jumper CONN HEADER VERT SGL 2POS 3M 961102-6404-AR
GOLD
24 |3 Q1,Q2,Q3 PMOS MOSFET P-CH 30V 3.8A SOT23-3 Diodes Inc DMP3098L-7
25 |1 R3 560 Q RES 560 Q 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ561V
R4,R11,R12,R14,R15,
26 |12 |R16,R24,R25,R32,R33 |ZERO RES 0.0 & 1/10W 0603 SMD Panasonic-ECG ERJ-3GEYOROOV
,R34,R45
27 |1 R5 ZERO RES 0.0 O 1/8W 0805 SMD Panasonic-ECG ERJ-6GEYOR0O0OV
28 |4 R8,R9,R22,R23 2.2K RES 2.2 kQ 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ222V
29 |2 R10,R41 47K RES 4.7 kQ 1/10W 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ472V
30 |1 R13 100K RES 100 kQ 1/10W 5% 0402 SMD Panasonic - ECG ERJ-2GEJ104X
31 |5 R17,R18,R19,R20,R21 [560 Q RES 560 Q 1/10W 5% 0603 SMD Panasonic-ECG ERJ-3GEYJ561V
32 |2 R26, R27 22E RES 22 O 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF22R0V
33 |1 R28 2.2K RES 2.2 kQ 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ222V
34 |2 R29,R30 1.5K RES 1.5 kQ 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ152V
35 |1 R31 330 Q RES 330 O 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ331V
36 |1 R35 2320 RES 232 O 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF2320V
37 |1 R36 120 Q RES 120 Q 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF1200V
38 |2 R37,R39 1.5K RES 1.5K Q 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ152V
39 |2 R38,R40 3K RES 3.0K Q 1/10W 5% 0603 SMD Panasonic - ECG ERJ-3GEYJ302V
40 |1 R42 1K RES 1K Q 1/8W 5% 0805 SMD Panasonic - ECG ERJ-6GEYJ102V
41 1 R43 442 O RES 442 O 1/10W 1% 0603 SMD Panasonic - ECG ERJ-3EKF4420V
SW PUSH- |SWITCH TACTILE SPST-NO 0.05A .
42 |2 SW1,SW2 BUTTON 12V Panasonic - ECG EVQ-PE105K
43 |1 TP5 BLACK TEST POINT PC MINI .040"D Black Keystone Electronics | 5001
44 |2 TVS1,TVS2 5V 350W TVS UNIDIR 350W 5V SOD-323 Dioded Inc. SD05-7
45 |1 TVS4 18V 350W  [TVS DIODE 18V 1CH BI SMD Bourns Inc. CDS0OD323-T18C
46 |1 U1 ZSESWDT NCP1117DTARKG ON Semiconductor |NCP1117DTARKG
PSoC 4 Cypress Semicon-
47 |1 u2 (CYBC4245A |44TQFP PSoC4A target chip yp CY8C4245AXI-483
ductor
X1-483)
PSoC 5LP . .
48 |1 U3 (CY8C5868L 68QFN PSoC 5LP ChIP fgr USB debug |Cypress Semicon- CY8C5868LTI-LPO39
channel and USB-Serial interface ductor
TI-LP039)
No Load Components
49 |1 C29 1.0 uFd %B:; CERAMIC 1.0UF 25V X5R 0603 Taiyo Yuden TMK107BJ105KA-T
0
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No. | Qty Reference Value Description Manufacturer Mfr Part Number
6X1 RECP |CONN FEMALE 6POS .100" R/A Sullins Connector
50 |1 J5 RA GOLD Solutions PPPCO061LGBN-RC
50MIL CONN HEADER 10 PIN 50MIL KEYED
51 |1 J7 KEYED SMD | SMD Samtec FTSH-105-01-L-DV-K
52 |1 11 2 PIN HDR CONN HEADER FEMALE 2POS .1 Sulllqs Connector PPPCO21LEBN-RC
GOLD Solutions
53 |1 12 3x2 RECPT CONN HEADER FMAL 6PS .1" DL Sulllqs Connector PPPCO32LFBN-RC
GOLD Solutions
54 |5 R1,R2,R7,R44,R46 ZERO RES 0.0 & 1/10W 0603 SMD Panasonic-ECG ERJ-3GEYOROOV
55 |1 R6 ZERO RES 0.0 Q 1/8W 0805 SMD Panasonic-ECG ERJ-6GEYOROOV
56 |2 TP1,TP2 RED TEST POINT PC MINI .040"D RED Keystone Electronics | 5000
57 |3 TP3,TP4,TP6 BLACK TEST POINT PC MINI .040"D Black Keystone Electronics 5001
58 |1 TVS3 5V 350W TVS UNIDIR 350W 5V SOD-323 Dioded Inc. SD05-7
Install on Bottom of PCB As per the Silk Screen in the Corners
59 |4 N/A N/A BUMPON CYLINDRICAL.312X.215 3M SJG1AG
BLACK
Special Jumper Installation Instructions
Install jumper
. Rectangular Connectors MINI JUMPER .
60 |1 J9 :2;0;3 pins 1 GF 6.0MM CLOSE TYPE BLACK Kobiconn 151-8010-E
Install jumper
. Rectangular Connectors MINI JUMPER .
61 |1 J13 :2;0;3 pins 1 GF 6.0MM CLOSE TYPE BLACK Kobiconn 151-8010-E
Label
LBL, Kit Product Identification Label,
Vendor Code, Datecode, Serial Number |Cypress Semicon-
62 1 N/A N/A CY8CKIT-042 Rev** (YYWWV- ductor
VXXXXX)
63 |1 N/A N/A LBL, PCBA Anti-Static Warning, 10mm |Cypress Semicon-
X 10mm ductor
64 |1 N/A N/A Assembly Adhesive Label, Manufactur- | Cypress Semicon-
ing ID ductor
. Cypress Semicon-
65 |1 N/A N/A Kit QR code
ductor
A.7 Regulatory Compliance Information

The CY8CKIT-042 PSoC 4 Pioneer Kit has been tested and verified to comply with the following
electromagnetic compatibility (EMC) regulations:

m EN 55022:2010 Class A - Emissions
m EN 55024:2010 Class A - Immunity
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A.8 Migrating projects across different Pioneer series kits

All Cypress Pioneer series kits are Arduino Uno compatible and have some common on-board
peripherals such as RGB LED, CapSense and User Switch. However, the pin mapping in each of the
boards is different due to differences in pin functions of the PSoC device used. This guide lists the
pin maps of the Pioneer series kits to allow for easy migration of projects across different kits.

In some cases, the pins available on the Pioneer kit headers are a superset of the standard Arduino
Uno pins. For example J2 contains only 1 row of pins on the Arduino Uno pinout while it contains 2
rows of pins on many of the Pioneer series kits.

Figure A-1. Pioneer series kits pin map

Arduino compatible
1/0 headers

Arduino compatible
power header

CY8CKIT-042-BLE
6x2 header

CY8CKIT-042 & CY8CKIT-044
9x2 header
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A.8.1 Arduino Uno Compatible Headers
J1 Arduino Compatible Header Pin Map
i Aeve 5T Pioneer series kits
CY8CKIT-042 CYSCKIT-040 |CYSCKIT-042-BLE| CY8CKIT-044

1 VIN VIN VIN VIN VIN

2 GND GND GND GND GND
3 GND GND GND GND GND
4 5V V5.0 V5.0 V5.0 V5.0
5 3.3V V3.3 V3.3 V3.3 V3.3
6 RESET RESET RESET RESET RESET
7 IOREF P4.VDD P4.VDD BLE.VDD P4.VDD
8 NC NC NC NC NC

J2 Arduino Compatible Header Pin Map
P Ao 5 Pioneer series kits
CYSCKIT-042 CYSCKIT-040 |CYSCKIT-042-BLE| CYSCKIT-044

1 AO P2[0] PO[0] P3[0] P2[0]
2 - PO[2]" - P2[0] P2[6]"
3 A1 P2[1] PO[1] P3[1] P2[1]
4 - PO[3]" - P2[1]" P6[5]"
5 A2 P2[2] PO[2] P3[2] P2[2]
6 - P4_VDD -~ P22 Po[6]”
7 A3 P2[3] PO[4]" P3[3] P2[3]
8 - P1[5]" - P2[3] P4[4]
9 A4 P2[4] P1[3] P3[4] P2[4]
10 - P1[4] - P2[4] P4[5]’
1 A5 P2[5] P1[2] P3[5] P2[5]
12 - P13 - P2[5]" P4[6]’
13 - PO[0] - - PO[0]
14 - GND - - GND
15 - PO[1] - - PO[1]
16 - P1[2] - - P3[4]’
17 - P1[0] - - PO[7]
18 - PI] - - P3[5]

* These pins are also used for on-board peripherals. See the tables in the On-Board Peripherals section
below for details.
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J3 Arduino Compatible Header Pin Map
P Ao 5 Pioneer series kits
CY8CKIT-042 CY8CKIT-040 |CY8CKIT-042-BLE| CY8CKIT-044
1 D8 P2[6] P1[4] PO[5] PO[2]
2 D9 P3[6] P1[5] PO[4] PO[3]
3 D10 P3[4] P1[6] PO[2] P2[7]
4 D11 P3[0] P1[1] PO[0] P6[0]
5 D12 P3[1] P3[1] PO[1] P6[1]
6 D13 PO[6] P1[7] PO[3] P6[2]
7 GND GND GND GND GND
8 AREF P1[7] NC VREF P1[7]
9 SDA P4[1] P1[3] P3[4] P4[1]
10 SCL P4[0] P1[2] P3[5] P4[0]

* These pins are also used for on-board peripherals. See the tables in the On-Board Peripherals section
below for connection details.

J4 Arduino Compatible Header Pin Map
i e Pioneer series kits
CY8CKIT-042 CY8CKIT-040 |CY8CKIT-042-BLE| CYB8CKIT-044
1 DO PO[4] PO[5] P1[4] P3[0]
2 D1 PO[5] PO[6] P1[5] P3[1]
3 D2 PO[7]* PO[7] P1[6] P1[0]
4 D3 P3[7] P3[2]" P1[7] P1[1]
5 D4 PO[0] PO[3] P1[3] P1[2]
6 D5 P3[5] P3[0] P1[2] P1[3]
7 D6 P1[0] P1[0] P1[1] P5[3]
8 D7 P2[7] P2[0]" P1[0] P5[8]

* These pins are also used for on-board peripherals. See the tables in the On-Board Peripherals section
below for connection details.
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A.8.2 On-Board Peripherals
CapSense Pin Map
Pioneer series kits
Pin# | Description CY8CKIT-042 CY8CKIT-042-BLE| CY8CKIT-044
. . CY8CKIT-040 . .
(Linear Slider) (Linear Slider) (Gesture Pad)
1 CSs1 P1[1] - P2[1] P4[4]
2 CsSSs2 P1[2] - P2[2] P4[5]
3 CSS3 P1[3] - P2[3] P4[6]
4 CSs4 P1[4] - P2[4] P3[4]
5 CSS5 P1[5] - P2[5] P3[5]
6 CMOD P4[2] PO[4] P4[0] P4[2]
7 CTANK P4[3] PO[2] P4[1] P4[3]
Proximity header Pin Map
Pioneer series kits
Pin # Description
CY8CKIT-042 CY8CKIT-040 |[CY8CKIT-042-BLE| CY8CKIT-044
1 - P2[0] P2[0] P3[7]
PROXIMITY
2 _ - - P3[6]
RGB LED Pin Map
Pioneer series kits
Pin # Color
CYB8CKIT-042 CY8CKIT-040 |CY8CKIT-042-BLE| CYB8CKIT-044
1 Red P1[6] P3[2] P2[6] PO[6]
Green PO[2] P1[1] P3[6] P2[6]
3 Blue PO[3] PO[2] P3[7] P6[5]
User Switch Pin Map
Pioneer series kits
Pin # Description
CY8CKIT-042 CY8CKIT-040 |[CY8CKIT-042-BLE| CY8CKIT-044
1 SW2 PO[7] - P2[7] PO[7]
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